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INTRODUCTION

While TASSEL has changed considerably since its initial public release in 2001, its primary function
continues to be providing tools to investigate the relationship between phenotypes and genotypes'. As
indicated by its title — Trait Analysis by aSSociation, Evolution and Linkage — TASSEL has multiple
functions, including association study, evaluating evolutionary relationships, analysis of linkage
disequilibrium, principal component analysis, cluster analysis, missing data imputation and data
visualization.

One of the design elements driving TASSEL development has been the need to analyze ever larger sets of
data®. For example, the MLM (mixed linear model) function for association analysis originally used an
EM (expectation-maximization) algorithm, which is a common method for solving mixed models but is
relatively slow. Subsequently developers implemented the EMMA algorithm to increase computing
speed’. Model compression was added to that to improve speed and statistical power for association
study®. Another technique that optimizes variance components once and then uses the estimates to test
markers now provides the ability to screen the large numbers of markers used in genome-wide association
studies (GWAS). The method was independently described by Zhang et al. and Kang et al. in 2010. This
method was named P3D by Zhang et al.* and EMMAX by Kang et al.’

TASSEL was designed for a wide range of users, including those not expert in statistics or computer
science. A GWAS using the mixed linear model method to incorporate information about population
structure®® and cryptic relationships’ can be performed by in a few steps by “clicking” on the proper
choices using a graphic interface. All the processes necessary for the analysis are performed
automatically, including importing phenotypic and genotype data, imputing missing data (phenotype or
genotype), filtering markers on minor allele frequency, generating principal components and a kinship
matrix to represent population structure and cryptic relationships, optimizing compression level and
performing GWAS.

The command-line version of TASSEL, called the Pipeline, provides users the ability to program tasks
using a script instead of the graphic user interface (GUI). This feature allows researchers to define tasks
using a few lines of code and provides the ability to use TASSEL as part of an analysis pipeline or to
perform simulation studies.

Due to the increasing availability of open data sources, TASSEL utilizes a data browser from the
Genomic Diversity and Phenotype Connection (GDPC) project'® to provide an interface to relational
databases. As a result, TASSEL users can access any data source that provides a GDPC service. Using
this middleware, which provides a common graphical interface, TASSEL users can avoid writing SQL
queries to access data. Currently, GDPC provides connections to Panzea, Gramene, Germinate, and GRIN
(USDA’s Germplasm Resources Information Network).

TASSEL is written in Java, thereby enabling its use with virtually any operating system. It can be
installed using Java Web Start technology by simply clicking on a link at www.maizegenetics.net/tassel.
A stand-alone version of TASSEL can also be downloaded to use in pipeline mode or in any situation
where the user wishes to start the software from a command line.




1 Getting Started

A quick way to get started using TASSEL is to load the tutorial data and try performing analyses.
However, because some of the necessary steps may not be intuitive, we recommend that new users follow
the tutorial at end of this manual. The objective of this section is to provide information necessary to
install and start TASSEL software and to provide a brief overview of the interface.

Most functions are organized into three modes (Data, Analysis and Results) which correspond to the first
three buttons on the TASSEL interface as shown below. Clicking one of these buttons changes the
functions represented by the second row of buttons. Those three modes are described in detail in the
subsequent sections of this manual. The screen shot shows TASSEL after the tutorial files have been

loaded.

B TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3.0.37

®6 GDPC
[_Eﬁ Data snnalysis @Results ‘Wizard l ’ B show Memary l [ 0% ) @
heGBRCLIZ11 0ad! | £ Fxpo k es | |P=Taxa [" Traits] [&5 Impute SNPsl [?+5 Transform] [pﬂq Synonymizerl [. u Join] [(D n Join] [OO Separatel
Data -~ . o .
Physical Positions Site Mumbers Locus Alleles
(=4 Sequence ©Phy ®) o o
% MdS_sequence i
- # mdp_genotype ‘ / | }
- # mdp_genotype 0 616 1232 1848 2464
« o ccoozeesozg
O = N M = 1 O ~ o o <« T v ¥« ¥« ¥ ¥ = v
=29 Numerical R I T = i N =
- # mdp_population_structure
P md::J:ra'ths - 38-11 MM N|N|N|N|N| NN N NNNN N NN NNNNA
565 Matrix - A272 Glc|t|c|a|lc|clalag|T|Cclalc|clalalc|la|T|C|aA
" & mdp_kinship A441-5 G|C|T|C|la|C|ClAa|Gg|T|ClACIC A ACIA|IT|C|A
® Tree - AS54 G|C|T|C|lAa|C|Cla|Gg|T|ClA/C/ClAAICIA|IT|C|A
® Fusions A6 G|C|T|C|la|C|C|Aa|G|T|ClACIC A A CIA|IT|C|A
# Synonymizer A619 G|C|T|C|la|C|Gg|Aa|Gg|C|ClA/ClClAlAICIA|IT|C|A
) Result A632 G|C|T|C|la|C|C|Aa|G|T|ClACIC A A CIA|IT|C|A
B103 G|C|T|C|la|C|C|Aa|G|T|ClA C/C A AICIA|IT|C|A
™ B104 G| C|T|ClA|C|ClAa|lGg|T|C|la|C|C|lalAa|C A|T|C|A
B144 G|C|T|C|la|C|Cl|Aa|G|T|ClAC/C A AICIA|IT|C|A
Nurber of sequences: 91 B37 G|C|T|C|a|C|ClalG|T|C|AalC|ClalalC|alT|C|A
Nuwber of sites: 2466 B68 Glcltlclalc|clala|[T[clalc|clalalclalT|cla
Data type: IUPACNucleotide B73 G|C|T|ClAa|C|Cla|lGg|T|C|la|C|C|lala|lC a|T|C|Aa
B84 G|C|T|C|la|C|C|Aa|G|T|ClACC A A CIA|IT|C|A
B97 G|C|T|C|la|C|Cla|Gg|T|ClA/C/C A AICIA|IT|C|A
C103 MIMN|N|N|N| NN NN NN NNNNNNNNNN
Lo CI187-2 G|C|T|C|la|C|C|Aa|G|T|ClAC/C A AICIA|IT|C|A
Tab L Cancel
< [—J El CM105 MIM|N|N|N| NN NN NN NNNNNNNNNN
CM174 G|C|T|C|la|C|Gg|Aa|G|C|C|lA/C/C A AICIA|IT|C|A
ZzecRBlot (I =T cm7 G|C|T|C|a|C|lG|a|G|c|c|alc|clalalc|alT|C|a
CML10 G|C|T|C|la|C|ClAa|G|T|ClA C/ClAACIA|IT|C|A
2D Plot [—] ﬂ] CML247 Glc|t|c|alc|clalag|T|Cclalc|clalalc|la|T|C|aA
CML254 G|C|T|C|la|C|C|Aa|G|T|ClAC/C A A CIA|IT|C|A
LD Plot (I § = CML258 GlC|T|C|la|C|c|alG|C|C|al|c|ClalalclalT|[C|A
CML261 G|C|T|C|la|C|Gg|Aa|Gg|C|CACIC A A CIA|IT|C|A
Chart [—][ Cancel ] Vi CML277 GlclTlclalc|clala|[T|clalc|clalalclalt|cla
< > CML281 G|C|T|C|la|C|C|Aa|G|T|C|A|C|CA A C AIT|ClA|V
atasets were saved ko test

1.1 Installation

The graphic version of TASSEL can be installed in one of the three ways: using Java Web Start, as a
stand-alone application, or using the source code

1.1.1 Web start

TASSEL can be installed using Java Web Start technology, which automatically checks for the most
recent version of TASSEL each time the application is executed. In addition, Java Web Start will ensure
that the correct version of the Java Runtime Environment is running, thus avoiding complicated
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installation and upgrade procedures. Users should use Web Start unless they have a specific reason to use
one of the other installation methods.

To begin, Java Web Start (JWS) must be installed (prior to the installation of TASSEL). JWS is included
as part of Java Runtime Environment (JRE) 5.0 and above. PC’s and Mac’s will most likely have JWS
already installed. If you need to install Java, the most recent version is available at http://www.java.com.

The easiest way to tell if it is installed on your computer is to try running TASSEL from the following
link:

http://www.maizegenetics.net/tassel

If you will be using TASSEL frequently and would prefer to launch the application from your desktop
rather than by revisiting the website, Java Web Start can be used to manually launch TASSEL each time
and/or to create a shortcut. Access the Java Application Cache Viewer by going to Start > Settings >
Control Panel > Java. From the General tab, click on Settings in the Temporary Internet Files section
and then click on View Applications... and the Java Application Cache Viewer will appear. (Another
way of achieving this is by going to Start > Run and typing in javaws). The TASSEL icon should now
be visible and can be used to launch the application. Shortcuts can be created from the menu of the Java
Application Cache Viewer: Application > Install Shortcuts.

1.1.2 Stand-alone

Downloading a “stand-alone” version is recommended for anyone who has a slow Internet connection.
While Java Web Start is a very good way of deploying software, it does not ask the user before attempting
to download updates. Thus, a slow Internet connection may start a download process that requires an
unreasonable amount of time to complete. If you are not interested in disabling your network connection
each time before starting TASSEL, we recommend downloading the stand-alone version which does not
attempt to update the program. However, given that TASSEL is a Java application, a Java Runtime
Environment (version 1.6.0 or greater) is still required. To get the stand-alone version, download
tassel3.0_standalone.zip from the TASSEL web site. To run the stand-alone version, double-click on the
JAR file (sSTASSEL.jar). Alternatively, from a command prompt (in Windows go to Start > Run and type
in “cmd” or “command”), change into the tassel3.0 standalone directory and execute this command:

start tassel.bat (For Windows)
start_tassel.pl (For UNIX)

1.1.3 Open source code

Open source code for the TASSEL software package is available at: http://sourceforge.net/projects/tassel.
The package uses a number of other libraries that are included in the TASSEL distribution. These include
a modified version of the PAL library (http://www.cebl.auckland.ac.nz/pal-project/), the COLT library
(http://dsd.Ibl.gov/~hoschek/colt/), and jFreeChart (http://www.jfree.org/jfreechart/). GDPC middleware
(http://www.maizegenetics.net/gdpc) provides database access.

1.2 Panels

TASSEL is organized into five main panels. (1) The Control Panel at the top contains menus and buttons
to control functions. (2) The Data Tree Panel is located beneath the Control Panel on the left side. This
panel organizes data sets and results. Data set(s) displayed in the Data Tree Panel must first be selected
before a desired function or analysis can be performed. To select multiple data sets, press the CTRL key
while selecting the data sets. (3) The Report Panel is located below the Data Tree Panel. It displays

8



information about a selected data set from the Data Tree Panel, such as the type of data and how it was
created. (4) The Progress Monitoring Panel below the Report Panel shows the progress of running tasks
and has buttons that can be used to cancel tasks. (5) The Main Panel occupies the right side of the viewing
area. It displays the content of a selected data set from the Data Tree Panel.

Functions in TASSEL are accessed by buttons and menus on the Control Panel.
The three buttons on the top left are the Mode Selectors (Data, Analysis and Results). The buttons below

the Mode Selectors changed when a new Mode Selector is clicked. The modes are described in section 2-
4. To the right of the Mode Selectors are the Progress Bar, and the Delete, Print, Save and Help buttons.



2 Data Mode | Epe= |

Data mode serves the purpose of importing and managing data. Data mode is the default mode when
TASSEL starts. Click on the Data button to switch to this mode.

Tassel has two ways of importing data. One way is via GDPC to import data from databases. The other
way is via flat files formatted as genotypes (e.g. hapmap, flapjack, and plink), phenotypes (trait data),
population structure and kinship matrices.

The preliminary data manipulations include filtering data by site or taxa, joining data and data
transformation.

2.1 GDPC +}60PC

Genotype and phenotype data generated from numerous genomic research projects are still valuable
resources for the public, even after results are published. Some of these data have been migrated to
several databases and can be accessed using Genotype Data and Phenotype Connection (GDPC). GDPC is
middleware that eliminates the need for end users of data to understand various database schemas and
write SQL queries to extract data. Instead, the GDPC browser provides a single, easy-to-use interface
which can extract genotype and phenotype data from a variety of sources'’. Currently, GDPC has
connections to the following databases:
¢ Gramene diversity for maize, wheat and rice'' ™"

http://www.gramene.org/db/diversity/diversity view

e Panzea”!
http://www.panzea.org
e GRIN

http://www.ars-grin.gov

GDPC can be used within TASSEL or as a stand-alone application. To display GDPC in TASSEL, click
on the GDPC button in Data mode.
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Data is available for import once the user has defined the desired filters and data is visible in either the
Genotypes or Phenotypes tab. To load data, activate either the Genotypes or Phenotypes tab (depending
L

on the data you wish to import) and then click the Load button w=.

For additional information about GDPC, please see http://www.maizegenetics.net/gdpc
2.2 Load

This function provides options to import files for genotypes, phenotypes, populations structure, and
kinship matrices. Several common sequence formats are accepted for genotype data, including BLOB,
Hapmap, Plink, and Flapjack, and a general format for polymorphism data. Some file types used by
TASSEL version 2 are also supported for backward compatibility. Phenotype and population structure
can be imported as numerical trait data or covariates. Kinship must be loaded as a square numerical
matrix.

Users can either specify the file type or use the “Guess” option to let the program determine the file type.
As an example, we describe how the “Guess” function can be used to import all the files from the tutorial
data set. The tutorial data can be downloaded from the TASSEL website or using this link:
http://www.maizegenetics.net/tassel/docs/TASSEL TutorialData3.zip.

To use the data, the zip file must be uncompressed and saved in a folder that the user specifies. To import
data click the LOAD button. The File Loader dialog box will then pop up to let user choose the files and
specify a format. For the files in the tutorial data set, the default (Guess) function will load all the files
correctly. Multiple files can be imported simultaneously by highlighting them first (holding Shift or
Control key while clicking) and then clicking the Open button.
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2.2.1BLOB

A Binary Large Object (BLOB) is a collection of binary data stored as a single entity. In TASSEL,
BLOBs are used to compress large data sets into more manageable sizes. For sequence data, three types of
BLOBs are used: SNP value BLOB, position BLOB and SNP ID BLOB. The three BLOBs are used to
store individual SNP values, SNP position within the genome and the SNP identifiers respectively.

A BLOB is composed of two components, a header and a body. The header for each BLOB is 1024 bytes
long, while the length of the body depends on the type of BLOB and on the amount of data being stored.

For a more detailed description on the structure and information contained within the header and body,
refer to the GDPDM BLOB Specifications.
(http://www.maizegenetics.net/gdpdm/docs/20100526/GDPDMBIlobSpecification_20100526.pdf)

2.2.2 Hapmap

Hapmap is a text based file format for storing sequence data. All the information for a series of SNPs as
well as the germplasm lines is stored in one file. The first row contains the header labels, and each
additional row contains all the information associated with a single SNP. The first 11 columns describe
attributes of the SNP, while the following columns describe the SNP value for a single germplasm line.
The first 12 columns of the first row should look like this, where “Line 1” is the beginning of germplasm
line names.

rs# | alleles | chrom | pos | strand | assembly# | center | protLSID | assayLSID | panelLSID | QCcode | Line 1

While all 11 header columns are required, not all 11 of the columns need to be filled in for TASSEL to
correctly interpret the data. The only required fields are “chrom”, Chromosome name, and “pos”,
Position.

For TASSEL to correctly read Hapmap data, the data must be in order of chromosome and position within
each chromosome, and the file should be TAB delimited. If some of the data is missing the correct
number of TABs must still be present, so that TASSEL can properly assign data to columns.

2.2.3 Plink

Plink is a whole genome association analysis toolset, which comes with its own text based data format.
The data is stored in a set of two files, a .map file and a .ped file.
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The .ped file contains all the SNP values and has six mandatory header columns for Family ID, Individual
ID, Paternal ID, Maternal ID, Sex and Phenotype. TASSEL only requires that the Individual ID field be
filled in. Each row of the .ped file describes a single germplasm line. Notice in Plink, an unknown
character is represented with a '0'. However in TASSEL an unknown character is represented with a 'N',
and '0' is used to represent heterozygous indel. TASSEL will automatically convert between the '0' and the
'N'. Any exported Plink files will represent the heterozygous indel with a '+' (insertion) and a '-' (deletion).

The .map file describes all the SNPs in the associated .ped file, where each row provides information on
one SNP. The .map file must contain exactly four columns: Chromosome, rs#, Genetic distance and
Position. TASSEL does not require the Genetic distance field to be filled in.

Both files should be TAB delimited.

For a more detailed description on the data format, please visit the Plink basic usage and data formats
webpage: (http://pngu.mgh.harvard.edu/~purcell/plink/data.shtml).

2.2.4 Flapjack

Flapjack is a software tool for graphical genotyping and haplotype visualization. The program is capable
of outputting data in its own text based data format. Like Plink, the data is stored in a set of two files, a
.map file and a .geno genotype file.

The genotype file contains all the SNP values. Each column in the first row contains a SNP ID, except for
the first column, which is blank. The first column of the following rows contains the germplasm line
names. TASSEL requires that all fields be filled out in order for data to be read correctly.

The .map file describes all the SNPs associated with the genotype file. Each row describes a single SNP.
There are three columns in the .map file for Flapjack, SNP ID, Chromosome and Position, all of which
are required for TASSEL to run correctly.

Both files should be TAB delimited.

For a more detailed description on the Flapjack data file format, please visit the Flapjack data import
website: (http://bioinf.scri.ac.uk/flapjack/help/gui.dialog. DatalmportDialog.shtml).

2.2.5 Polymorphism

A general format that accepts almost any type of marker data can also be used. Any alphanumeric
character is allowed. Diploid data can be represented by separating alleles with a colon (“:”), for example
A:A, A:B, or B:B. All loci in a file must have the same ploidy level. The first line starts with the symbol
<Marker> followed by the marker names. Subsequent lines must start with the name of the individual or
taxon genotyped followed by the marker scores in the same order as the header. Comments can be
inserted at the beginning of the file as long as any comment lines begin with the symbol “#”. Columns are
TAB delimited. Numeric values are allowed but, by default, will be treated as classification variables not

as covariates in analyses.
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Example 1:

<Marker> ml m2 m3 mé m5
33-16 A B B A A
38-11 A A B A A
4226 A B B A B

In some cases, a user may wish to have marker values treated as numerical covariates. If the first line of
the file is “<Numeric>", then the data will be imported as numeric data but used as marker data in GLM
and MLM.

Example 2:
<Numeric>
<Marker> ml
33-16 0 1
38-11 O 0
1

4226 0

[ el =
oo o3
U W

oo o3

Note to TASSEL 2.1 users: The polymorphism format specified in TASSEL v2.1 is still supported to
provide backward compatibility.

2.2.6 Phylip

The Phylip format used by TASSEL version 2.1 will continue to be supported. Details on Phylip format
are described at the following website: http://evolution.genetics.washington.edu/phylip/doc/sequence.html

2.2.7 Numerical data

This type of format is used for trait and covariate data such as population structure. Similar to sequence
alignment genotype data, numerical data also consists of two parts: a header that defines data structure
and a body containing the main data. Tabs should be used as delimiters. However, any white space
character such as blank will be treated as a delimiter as well. As a result, embedded blanks in names will
cause data to be imported incorrectly. We suggest representing missing values using “NA”, or “NaN”.
However, any text value (e.g. “?”’) will be interpreted as missing data. There are several formats for
numerical data to fit the requirement for modeling. Trait data (dependent variables) can be imported by
starting the first line with “<Trait>" and following that with the trait names. Additional classifiers may
also be included in subsequent header rows by starting the row with “<Header name=xxx>"" followed by a
name for each column of data. For instance, to define environments, start the second header row with
“<Header name=env>"".

Comment lines may be inserted at the beginning of the file as long as each comment line begins with the
character “#”.

2.2.7.1 Trait format

This format does not require users to provide information on number of rows and columns. The file stats
with key word <Trait> followed by names of columns. The column for line should not be labeled.

Example 1, simple list of trait values:
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<Trait> EarHT dpoll EarDia
811 59.5 NA NA

33-16 64.75 64.5 NA

38-11 92.25 68.5 37.897
4226 65.5 59.5 32.21933
4722 81.13 71.5 32.421
Al88 27.5 62 31.419

Example 2, traits data collected in multiple environments:

<Trait> EarHT PlantHT EarHT PlantHt
<Header name=env> Locl Locl Loc2 Loc2
811 59.5 NA NA NA

33-16 64.75 121.5 NA NA

38-11 92.25 153.8 37.897 83.4

4226 65.5 130.1 32.21933 82.1

4722 81.13 165.7 32.421 90.1

A188 27.5 110.2 31.419 79.6

2.2.7.2 Covariate Format

Covariate data uses the same format as trait data except that the first line must be “<Covariate>". This line
tells TASSEL that the variables in this file will be used as covariates not as dependent variables. This is
the format to use for population structure covariates.

Example:

<Covariate>

<Trait> 01 Q2 03
33-16 0.014 0.972 0.014
38-11 0.003 0.993 0.004
4226 0.071 0.917 0.012
4722 0.035 0.854 0.111
A188 0.013 0.982 0.005

2.2.7.3 TASSEL version 2.1 formats

Version 2.1 formats for numeric data will continue to be supported to provide backward compatibility.
However, that format does not identify covariates as such. As a result, any covariates imported using this
format will need to be properly identified using the “Trait filter” function described later in the manual.

2.2.7.4 Repeated measurements

A format for repeated measurements may be implemented in the future.
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2.2.8 Square Numerical Matrix

Kinship can be calculated externally from pedigrees by using SAS Proc Inbreeding'® or from markers by
using software packages such as SPAGedi'’. The following format is provided to import the resulting
kinship estimates:

If n represents the number of taxa, the format for kinship files is as follows:

n

TaxalName ri11 r12 ... rin

Taxa2Name r21 122 ... r2n

TaxanName rnl rn2 ... rnn

Here rij (1, j=1,2, ..., n) is the element in the kinship matrix located at row i and column j.

Missing values are not allowed for kinship matrix.

Important note: The current format is different from the format used in TASSEL version 2.0 or lower.

2.2.9 Genetic Map

A Genetic Map is a list of markers with chromosome and map position and, optionally, physical position.
It can be used by GLM and MLM to provide genetic positions in the output files. It is not used as part of
the analysis. The input format is:

First line: <Map> (as is, including the brackets)
Following lines: marker name, chromosome name, genetic position, physical position (actual data)

Example:

<Map>

markerl cl 21.3 2456873
marker2 cl 52.1 52345691

There is no header line as such. Marker name, chromosome name, and genetic position are required.

Physical position is optional and not used at this time. It is there because it is anticipated that information
from this map may be used to convert between physical and genetic position at some time in the future.

2.3 Export & Export

Options are provided to export sequence data: BLOB, Hapmap, Plink, Flapjack, Phylip (Sequential or
Interleaved). Phenotypes and covariate data is exported as numerical trait data. Table Reports are exported
as a tab delimited table.

This button has the same function as the “Save selected as” on the File menu. For numerical data, the
function of Export is similar to the Table function in Results mode.
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2.4 Sites |V Sttes|

The alignment can be filtered in several ways. Monomorphic sites can be eliminated, and regions of a
sequence can be eliminated.

| ] Filter Alignment =

Filter Alignment
Minimum Count: 68 out of 91 sequences

Minimum Frequency: 0.05
Position Type: Position index Physical Position (AGP)

Start Position: o o

End Position: 2465 2465
of 2466 sites

Extract Indels

Remove minor SNP states

Generate haplotypes via siding window

Filter Cancel

Minimum Count - the minimum number of taxa in which the site must have been scored to be included
in the filtered data set (GAP or missing data do not count).

Minimum Frequency - the minimum frequency of the minority polymorphisms for the site to be
included in the filtered data set.

Start Position, End Position — establishes the range of sites for filtering.

Extract Indels - if selected, indels are extracted from the alignment. If not selected, only point
substitutions are extracted.

Remove minor SNP states — converts tertiary and rarer states to missing data (“?”), thereby forcing sites
to have only two types of segregating sites at a locus. This may help remove sequencing errors.

Generate haplotypes via sliding window — creates haplotypes from an ordered set of SNPs.
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2.5 Site Names ¥ Site Names

First select genotypic data from the data tree. The resulting dialog displays the site names associated with
the selected data. By using either the CTRL or SHIFT key in conjunction with the mouse, the user can
select or deselect site names. Once desired site names have been moved to the “Selected” window using
the “Add ->” button, the “Capture Selected” or “Capture Unselected” buttons will create a new data set

containing only the desired taxa.
Using the search box...

* *is the wildcard.
* *isalways implied at end of search string.

» Search string is case sensitive. For example: use [Aa]bc to match taxa beginning with Abc or abc.

* PZ[AB] Will match anything starting with PZA or PZB.

eSO Site Name Filter
Available Selected
PZB00859.1 ¢| PZAD3613.2
PZAO1271.1 PZAO3613.1

PZA03613.2 PZA02962.13
PZA03613.1
PZA03614.2

PZA03614.1
PZAD0258.3

PZA02962.13 E

[PZA02962.14 7]
PZ[AB]

( Capture Selected ) ( Capture Unselected ) ( Remove )
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2.6 Taxa

First select genotypic, phenotypic, or population structure data from the data tree. The resulting dialog
displays the taxa associated with the selected data. By using either the CTRL or SHIFT key in
conjunction with the mouse, the user can select or deselect taxa. Once desired taxa have been moved to
the “Selected” window using the “Add ->" button, the “Capture Selected” or “Capture Unselected”
buttons will create a new data set containing only the desired taxa.

Using the search box...

* *is the wildcard.

* *isalways implied at end of search string.

» Search string is case sensitive. For example: use [Aa]bc to match taxa beginning with Abc or abc.
* A[56] Will match anything starting with AS or A6

8.N).60 Taxa Filter
Available Selected
; A556

Ab

AB19

AB32

AB34
' N\ ' Y - Y - Y
[ Capture Selected ) [ Capture Unselected | [ Remove | [ Cancel )

2.7 Traits

Clicking the “Traits” button on the “Data” toolbar launches the Trait Filter dialog. This dialog is used
with numerical data sets to (1) change the trait type, (2) view, but not change whether the trait is discrete
or continuous and (3) drop one or more traits from the data set. In addition, the dialog can be used to view
the trait properties without changing them. If the “OK” button is clicked, a new data set is created that
incorporates the changes, the original data set remains unchanged, and the dialog closes. If the “Cancel”
button is clicked no data set is created, the original data set remains unchanged, and the dialog closes.
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Allowable trait types are data, covariate, factor and marker. Generally, data and covariate traits will be
continuous (not discrete) and factor will be discrete. Markers in a numerical data set will be continuous.
Discrete valued markers are better imported as sequence or polymorphisms.

Clicking “Exclude All” unchecks the “Include” box for all traits. Clicking “Include All” checks the
“Include” box for all traits. The “Exclude Selected” and “Include Selected” buttons do the same thing for
traits that have been highlighted by selecting them with the mouse.

Important: Once a numerical data set has been joined with genotypes, it can no longer be modified using
the trait filter function.

] Filter Traits / Modify Trait Properties ==

Trait Type Discrete Include

[ Excudeselected | [ Indude Selected |

Indude Al

2.8 Impute SNPs lﬁ" Impute SNPs

This function is used to impute missing genotypes. A sequence data type is required to use the function.

2.9 Transform [7+5 Transform|

This suite of functions allows multiple data manipulation on genotype and phenotype (numerical) data.
When a genotype data set is selected, the data are transformed to numbers. When a numerical data set is
selected, mathematical transformation, data imputation and principal component analysis (PCA) can be
performed. The Transform columns tags will be displayed in a Data dialog box with three tabs: Trans,
Impute and PCA.

2.9.1 Genotype Numericalization 295 Transform|

Two options are provided to transform genotype from character to numerical as shown in the following
dialog box.
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% (S

iNumerical Genotype ‘

@ Collapse Non Major Alleles

() Separate Alleles

Create Dataset ][ Close ]

2.9.1.1 Collapse Non Major Alleles

This function assigns 1 to the major allele and 0 to any other alleles. The converted genotypes are saved in
a new numerical data set.

2.9.1.2 Separate Alleles

This function assigns an indicator (1 for present and 0 for absent) for each allele. The converted genotypes
are saved in a new numerical data set.

2.9.2 Transform and/or Standardize Data

The Trans dialog box is the default selection, as shown below. In the Column list, select the column(s)
you wish to transform. Then select the type of transformation you wish to execute. Selecting the
Standardize checkbox will transform data by subtracting the column mean from the value of the trait and
then dividing by the column’s standard deviation. Clicking on the Create Data set button will result in
the placement of a dataset containing only the selected columns in the Data Tree.

Column Percent Missing Data Trans | Impute | PCA

(©) Raise to Power | 2 v

(") Take Log Base 10 -

[] Standardize

Create Dataset ][ Close ]
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2.9.3 Impute Phenotype

The k-nearest-neighbor algorithm® is used to impute missing phenotype data. If data is missing for a
taxon for one of the traits, the algorithm finds other taxa (neighbors) that are most like it for the non-
missing traits. It uses the average of the neighbors to impute the missing data. Click on the Impute tab to
display the following:

& A -~ =5
Column Percent Missing Data Impute -

(@ Manhatten Distance

(© Eudid Distance

@ Unweighted Average

() Weighted Average

Number of Neighbors (K): 3

Min. Freq. of Row Data: 0.80

Create Dataset ][ Close ]
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2.9.4 PCA

Principal component analysis (PCA) can only be performed on a numerical data set without missing
values. Two methods are available: correlation or covariance. This determines whether a correlation or
covariance matrix will be used as the basis for the analysis. The default, correlation, is a reasonable choice
for genetic data. The number of PCA axes in the output data set can be controlled by selecting either of
the minimum eigen value associated with each axis, the minimum percent of the variance captured by an
axis or the number of axes. The resulting axes will be sorted by the amount of variance each captures.

Column Percent Missing Data Trans | Impute | PCA
EarHT.NA 0.00
dpoll.NA 0.00 Method
R L (®) Correlation

() Covariance

Output

(3) Eigenvalue 2 |0

(O VarProp % = |0.33333 '

() Components = |32

[ Create Dataset ][ Close ]

2.10 Synonymize Taxa Names P=q synonymizer,

* This button makes taxa names uniform to permit the joining of data sets.

The join functions that generate fused data sets work by matching taxa names. Consequently, if multiple
names exist for a given taxon (an added suffix, alternative spellings, different naming conventions, etc.)
then the two data sets will not join correctly. To help remedy this, the Synonymizer function allows the
taxa names of one data set to replace similar taxa names in the second data set. It relies on an algorithm
that calculates the degree of similarity between names, using the name from the first set which is most
similar to that in the second data set.

When using the Synonymizer, keep in mind that order of selection matters. Always select the data set
with the names you wish to use (the “real” name) first, and then, while holding down the CTRL key, click
on the second data set with the taxa names you wish to change (the “synonym”). Then click on the
Synonymizer button. A synonym data set will be placed on the Data Tree panel under Synonyms. Each
name in the data set selected second is now listed in the TaxaSynonym column. Next to this column is a
TaxaRealName column listing the highest scoring match derived from the “real” name data set. The
MatchScore column gives an indication of the amount of similarity between the two names (where 0 is
no similarity and 1.0 is identity).
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| £| TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3.0.36 EM
File Tools Help GDPC

— _ 5
s Data " °Analysis ] @Resul(s ] [ Wizard ] [ [ Show Memory ] 0% | E]
lm GDPCI [El Load] [ﬁ Exporl] T sites| [P=Taxa| | ¥ Traits [&5 Impute SNPs] [?*5 Transform] [pwq Synonymilerl [.u Join] [(I)nJoin] [OO Separate]
| Data “ || TaxaSyno... TaxaRealN... ReflDNum MatchScore
= |, Sequence 7111 1 0.0 gl
@ d_sequence frz110 frzi10 82 10
- mdp_genotype 579 673 [ 5 )
# Polymorphisms AB28A 1 00 =
= J. Numerical 577 873 ) 0.5
- # mdp_population_structure M3 37w 52 10
| @ mdp traits B76 B73 12 0.5
B Matrix GE ki3 a7 10
- mdp_kinship 575 673 I 5
® Tree GT112 GT112 37 1.0
i * :;:::‘jmizer ci31A ki3 a7 0.33333355
o B73 B73 12 1.0
® [ VAS9 554 3 0.33333333...
Ji Resuit c1as Kiaa ® .
ICMLS2 ICML5 29 0.57142857...
- | [cmiet cMLs 2 0.57142857...
C17 IC1187-2 16 0.25
Table Title: Taxa Synonym Table ICMLS ICMLS 29 1.0
Number of columns: 4 SC55 ISC55 78 1.0
Number of rows: 301 OH78 OH78 72 L0
Number of elements: 1204 3637:“ ::[6377‘\ :3 ;3
Taxa synonyms cM37 M37W 52
Synonym Table 65 63 11 10
301 unique matches B115 1 0.0
73 unmatched: B64 B68 11 0.5
H100 1 0.0
DE811 KI11 45 0.28571428...
CHS HSS 38 0.5
Load ——— | Cancel CO255 K55 44 0.33333333...
INC372 1 0.0
INC370 1 0.0
Synongmizer | | Cancel U2s7¢ u2s7¢ s 10
8109 -1 0.0
|WF9 |WF9 190 1.0 ol
ogram Status )

Caution! Before the synonyms are applied, we strongly encourage the user to check the match score,
especially for those taxa with low match scores. To do that, the user selects the synonym file and clicks
the “Synonymizer” button. The incorrect matches, usually the ones with the lowest match scores, can be
rejected at this point. Sorting on the match score column first makes this a fairly easy process.

In the event that some of the taxa are not interpreted correctly, matches can be modified manually. Select
the taxa you wish to modify on the left side, and then choose a replacement taxa from the right side. Click

the arrow button E] to substitute the taxa. Taxa with no synonym can be identified by selecting then
clicking “No Synonym”. Click OK to save the changes.
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-
|£| Threshold for synonymizer _ E
Synonymizer
TaxaSy... TaxaRe... ReflDNum MatchSc... TZ118 |~
TZI11 -1 0.0 - T;;O
TZI10 TZI10 82 1.0 !EI K111 -
B79 B73 12 0.5 33-11 1
AB2BA -1 0.0 cT112
B77 B73 12 0.5 W117HT
|M37W M37W 52 1.0 1137TN
B76 B73 12 0.5 C1187-2
KI3 KI3 47 1.0 WES
B75 B73 12 0.5 WE4A
GT112 GT112 37 1.0 < W 1828
| |CI31A KI3 47 0.333333... W153R
B73 B73 12 1.0 U267Y
VASS AS554 3 0.333333... X601
Cl44 K144 49 0.666666... T232
CMLS2 CML5 29 0.571428... SG18
||CML91 CML5 29 0.571428... SC55
CI7 CI187-2 16 0.25 SC213R
CMLS CML5 29 1.0 SA24
SC55 SC55 78 1.0 Q6199
OH7B OH7B 72 1.0 PAS1
IL677A IL677A 43 1.0 - ban -
[] Sort Alphabetically
[ No Synonym ] . ’
| ‘ Apply threshold
.

Once it has been determined that the taxa names were matched correctly, the synonyms can be applied.
With the synonyms selected, hold down the CTRL key while clicking on the second/synonym data set
(the data set whose names you would like to change). Then once again click on the Synonymizer button
to apply the new names to the data set.

2.11Union Join

This button joins multiple data sets by a union of their taxa. Missing data will be inserted if taxa are
missing from one data set.

Select multiple data sets using the CTRL key in conjunction with mouse clicks, and then click on the
union button to join the data sets.

Because this function uses taxa names to join data sets, any variation in taxa names can prevent proper
joining. Taxa names can be made uniform by using the “Synonymizer”.
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2.12 Intersection Join @ 0 Jon|

This button joins multiple data sets by the intersection of their taxa. Taxa must be present in both data sets
to be included.

Select multiple data sets using the CTRL key in conjunction with mouse clicks, and then click on the
intersection button to join the data sets.

Because this function uses taxa names to join data sets, any variation in taxa names can prevent proper
, any
joining. Taxa names can be made uniform by using the “Synonymizer”.
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3 Analysis Mode

Analysis mode consists of the following options:

3.1 Diversity

This button executes a basic diversity analysis.

Average pairwise divergence (m), segregating sites, and 0 estimates (4Np) can be calculated, as well as
sliding windows of diversity.

To run a diversity analysis, click on a raw sequence alignment, and then select Analysis = Diversity.

r Y
| £ Diversity Surveys &J

StartBase 0

EndBase 2465

rensnEs [~ Sliding Window
Step 100

Window 500

[7] Indels

[ Run ][ Close ]

|

In the resulting Diversity Surveys dialog box, the various site classes available for analysis are listed on
the left. If the sequence has no annotation, then only the “Overall” and “Indels” options will be active.

A sliding window of diversity can also be calculated across the region. To produce a sliding window,
check the box next to “Sliding Window,” and then enter the desired step size and size of the sliding

window.

Results can be plotted using Results = Chart or viewed in a table via Results = Table.

27



3.2 Linkage Disequilibrium [ bnk Disea

This button generates a linkage disequilibrium data set from SNP data.

NOTE: It is important to use only filtered data sets (apply Data => Sites first) when estimating linkage
disequilibrium, as a raw alignment with numerous invariant bases will take a very long time and consume

a large amount of memory to calculate.
| %/ Linkage Disequilibrium &J

Full Matrix LD
@) Sliding Window LD

50 LD Window Size

Linkage disequilibrium between any set of polymorphisms can be estimated by clicking on a filtered set
of polymorphisms and then using Analysis = Link. Diseq. At this time, D', 2 and P-values will be
estimated. The current version calculates LD between haplotypes with known phase only (unphased
diploid genotypes are not supported; see PowerMarker or Arlequin for genotype support).

D' is the standardized disequilibrium coefficient, a useful statistic for determining whether
recombination or homoplasy has occurred between a pair of alleles.

¥’ represents the correlation between alleles at two loci, which is informative for evaluating the
resolution of association approaches.

D' and 2 can be calculated®' when only two alleles are present. If multiple alleles are present, a weighted
average of D' or r2 is calculated between the two loci”>. This weighted average is determined by
calculating D’ or »2 for all possible combinations of alleles, and then weighting them according to the
allele's frequency. Note: It is not entirely certain that this procedure fully accounts for allele number

effects.

P-values are determined by two methods. If only two alleles are present at both loci, then a two-sided
Fisher's Exact test is calculated. Note: Previous editions of TASSEL used a one-sided test, but TASSEL
version 1.0.8 and later use a two-sided test.

If more than two alleles are present, permutations are used to calculate the proportion of permuted gamete
distributions that are less probable then the observed gamete distribution under the null hypothesis of
independence®' .
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When calculating linkage disequilibrium, users have the option of employing “Rapid Permutations.” If
this option is selected, the algorithm will compute either a fixed number of permutations or run until 10
permutations are found that are more significant than the observed P-value. While this slightly reduces P-
values, it also saves a large amount of computational time. If an unbiased p-value is desired, then the user
must unselect the “Rapid Permutations” check box.

“Full Matrix LD” calculates LD for every combination of sites in the alignment. “Sliding Window LD”
calculates LD for sites within a window of sites surrounding the current site. The LD Window Size

determines the width of the window on one side of the current site.

Linkage disequilibrium results can be plotted using Results = LD Plot or viewed in a table via
(Results > Table).

3.3 Cladogram ¥ Ciadoaram

This function generates a tree or cladogram data set.

TASSEL produces neighbor-joining trees using only simple parsimony substitution models.

To retrieve cladogram data, first select genotypic data from the Data Tree panel and then click on the
“Analysis” button, followed by the “Cladogram” button. The resulting tree data and the corresponding

matrix will appear as separate data sets on the Data Tree panel.

Results can be plotted using Results = Tree Plot.

3.4 SNP Extract ¥ S Extract

“SNP Extract” extracts SNPs from a raw sequence alignment into a useful format for export.
Additionally, this function provides information for designing genotyping assays.

Below is a detailed explanation of the SNP Extractor Dialog:

%] SNP Extractor Dialog &J

Minimum Site Frequency: 0.85
Minimum SNP Frequency: 0.05

Minimum Surrounding Bases: 150
Minimum Good SBE Bases:

V| Filter SNPs to Biallelic

Minimum Site Frequency: the minimum frequency for which the site must have a good base
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Minimum SNP Frequency: the minimum frequency of the minority polymorphisms for the site to be
included in the resulting data set

Minimum Surrounding Bases: the minimum number of good bases on at least one side of the SNP
Minimum Good SBE Bases: the minimum number of good bases on at least one side of SNP

Filter SNPs to Biallelic: converts tertiary and rarer states to missing data (“?”), thereby forcing sites to
have only two types of segregating sites at any particular locus. This helps to remove bad sequence
effects.

Results are displayed on the Data Tree panel and include SNPs along with their context. Additional
information is also provided, including: the location of the nearest polymorphisms on either side,
polymorphism information content (“PIC”) and “Haplotype PIC”. “Overall score” is essentially an
estimate of the ability to design a single-base pair extension reaction in the region.

These results can be exported by using a table (Results = Table).

3.5 Kinship |'* Kinship

The function generates a kinship matrix from a set of random SNPs. To do so, first highlight SNP data
then click on the “Analysis” button, followed by the “Kinship” button. The resulting kinship data will be
added as a data set on the Data Tree panel.

When a genotype file is selected, the kinship matrix is generated by first using the TASSEL Cladogram
function to calculate a distance matrix. Each element d;; of the distance matrix is equal to the proportion
of the SNPs which are different between taxon i and taxon j. The distance matrix is converted to a
similarity matrix by subtracting all values from 2 then scaling so that the minimum value in the matrix is
0 and the maximum value is 2. Kinship can be derived from a set of random SNP data (a minimum of
several hundred SNPs spread over the whole genome is recommended).

Warning: This method currently works correctly only for homozygous inbred lines. The method will be
modified in the near future to work with heterozygous taxa. At that point, this warning will be removed.

Users may also load their own kinship data using Data = Load. Kinship matrices can be calculated
using the SPAGeDi software package (http://www.ulb.ac.be/sciences/ecoevol/spagedi.html).
Comparisons of methods for calculating kinship can be found in the literature (e.g. Stich et al. 2008).

3.6 General Linear Model ¥ 6tM

This function performs association analysis using a least squares fixed effects linear model.

TASSEL utilizes a fixed effects linear model to test for association between segregating sites and
phenotypes. The analysis optionally accounts for population structure using covariates that indicate
degree of membership in underlying populations. A main effects only model is automatically built using
all variable in the input data. A separate model is built and solved for each trait and marker combination.
Any factors, covariates, reps or locations are included in every model as main effects. How the data is
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used must be defined either in the input data files or using the Trait Filter after the data has been
imported but before it has been joined with a genotype.

General Linear Model (GLM) can be run using a numeric data set only, numeric data joined to genotype
data. If only numeric data is selected, best linear unbiased estimates (BLUEs or least square means) will
be generated for the taxa for each trait. [Note: only factors and covariates intended to control field
variation should be included at this stage. Population structure covariates which are intended to control for
marker effects should only be included when markers are also in the analysis.] If numeric data with
genotypes are analyzed, each trait by marker combination will be tested and two reports will be produced,
one containing trait by marker F-tests and the other containing allele estimates.

To run GLM, select a data set and then click the GLM button. A dialog box will pop-up to allow the user
to indicate that a permutation test should be run and to allow the number of permutations to be changed.
The permutation test will be run using the method suggested by Anderson and Ter Braak (2003), which
calculates the predicted and residual values of the reduced model (contained all terms except markers)
then permutes the residuals and adds them to the predicted values. When the GLM options dialog is
closed, the user is presented with a dialog allowing the output to be saved to a file rather than stored in
memory and displayed by TASSEL. This option is useful when the output is expected to be very large and
risks exceeding available RAM.

The following table shows an example of the Marker Test output as viewed with Results/Table:

T Marker Test . _ e - . &J
Trait Marker Locus Locus_pos marker_F marker_p markerR2 markerDF markerMS errorDF errorMS modelDF modelMS
EarDia PZB00859.1 1 157104 1.663] 0.199 0.007 1 23.522 223 14.144 3 31921 &
EarDia PZA01271.1 1 1947984 0.005 0.942 0 1 0.076 222 14.081 3 22.88
EarDia PZA03613.2 1 2914066/ 0.144 0.705 0.001 1 2.126 227, 14.791] 3 27.224
EarDia PZA03613.1 1 2914171 0.014 0.905; 0 1 0.208 228 14.66 3 24.487|
EarDia PZAD3614.2 1 2915078 0.018 0.8%4 0 1 0.261 215 14.742 3 35.401
EarDia PPZAD3614.1 1 2915242 2.663 0.104 0.012 1 39.907 213 14.984 3 38.967
EarDia PZA0D0258.3 1 2973508 0.42 0.517| 0.002 1 6.089 209 14.487 3 25.438
EarDia PZA02962.13 |1 3205252 0.374 0.541 0.002; 1 5.374 217 14.357| 3 25.183| ¥
< »

[ Print | [ Export(csv) | [ Export(rab) |

In addition to displaying the F-statistics and p-values for the requested F-tests, the table also contains
markerR2, mean squares (MS) and degrees of freedom (DF) for the marker effect, for the model
(corrected for the mean), and for error. If taxa are replicated (across reps or environments), then the
markers are tested using the taxa within marker mean square. If taxa are unreplicated, then the residual
mean square is used. MarkerR2 is the marginal R2 for the marker calculated as SS Marker (after fitting all
other model terms) / SS Total, where SS stands for sum of squares. The following table shows an example
of the Allele Estimates output as viewed with Results/Table:

T Allele Estimates li_&J
Trait Marker Obs Locus Locus_pos Allele Estimate

EarDia PZB00859.1 181{1 157104/C 0.804| -
EarDia PZB00859.1 46|1 157104|A 0
EarDia PZAD1271.1 117|1 1947984(G 0.039
EarDia PZAD1271.1 109|1 1947984/|C 0
FarNiz D7AN2E12 D /Ql1 J01ancAIrn n 212 Y
< »

[ Print ] [ Export (CSV) ] [ Export (Tab) ]
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For each marker and trait combination, each marker allele is listed along with the number of observations
for taxa carrying that allele (Obs), the locus (usually chromosome) and locus position of that marker, the
allele, and the estimate of the effect of that allele. Because of the way that GLM codes alleles, the last
allele estimate for a marker is always zero and the other allele estimates are relative to that.

B
3.7 Mixed Linear Model b/ MM

This conducts association analysis via a mixed linear model (MLM).

A mixed model is one which includes both fixed and random effects. Including random effects gives
MLM the ability to incorporate information about relationships among individuals. When a genetic
marker based kinship matrix (K) is used jointly with population structure (Q), the “Q+K” approach
improves statistical power compared to “Q” only’. MLM can be described in Henderson’s matrix
notation™ as follows:

y=Xp+Zu-+e

where y is the vector of observations; B is an unknown vector containing fixed effects, including genetic
marker and population structure (Q); u is an unknown vector of random additive genetic effects from
multiple background QTL for individuals/lines; X and Z are the known design matrices; and e is the
unobserved vector of random residual. The u and e vectors are assumed to be normally distributed with
null mean and variance of

u G 0
Var =
e 0 R
where G = |:|K With|:| as the additive genetic variance and K as the kinship matrix. Homogeneous

variance is assumed for the residual effect which means R=I|:|, where |:| is the residual variance. The
proportion of genetic variance over the total variance is defined as heritability (h?).

2
(¢

2 _ a
h 2 2
G, +0,

When K is derived from pedigrees, the elements of K equal 2*Probability(IBD), where IBD means that
two alleles drawn at random are identical by descent. Generally, K calculated from markers is an IBS
matrix. The resulting multiplier is then not ,> but some unknown constant times o,”. Some methods for
calculating K, such as those implemented in SPaGEDI, actually use markers to develop an estimate of the
IBD relationship matrix. For those values of K, the resulting variance estimate can be considered an
estimate of o,” as long as the assumptions of the method used to derive K are not violated for the
population being analyzed. One implication is that two different K matrices may give very different
estimates of o, and heritability yet produce the same model fit and test of marker association.

TASSEL implements several methods to improve statistical power and reduce computing time. The
Restricted Maximum Likelihood (REML) estimates of 6. and 6’ are obtained through the Efficient
Mixed-Model Association (EMMA) algorithm® which is much faster than the expectation and
maximization (EM) algorithm®.
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TASSEL also implements a method called compression which reduces the dimensionality of the kinship
matrix to reduce computational time and improve model fitting. When MLM is used without compression
(compression = 1), each taxon belongs to its own group. At the other extreme, GLM can be interpreted as
maximum compression (compression = n) with all taxa in a single group. In that case, it is not possible to

estimate the random effect independently of error and 6. is absorbed into 6’. Between these two

extremes, taxa can be grouped using cluster analysis based on kinship. When n individuals are
compressed into s clusters (groups), the kinship among individuals is replaced with the kinship among
groups. At some grouping levels, dependent on the trait and population being analyzed, this compressed
MLM has improved statistical power compared to the regular MLM®. The optimum grouping with the
best model fit for MLM without fitting genetic markers has the best statistical power for an association
test of markers*. TASSEL allows users to specify the compression level (average number of individuals
per group), or to have the program determine the optimum grouping.

Similar to GLM, MLM performs an association test for each combination of traits and markers. TASSEL
provides users several options: 1) to estimate genetic and residual variance for each combination; 2) to
get these estimates once for each trait without fitting genetic markers and then to use those estimates to
test markers; 3) to use a prior heritability estimate provided by the user. The second option, named P3D
(population parameters previously determined), has the same statistical power as the first option®. Using
the P3D method or using a prior heritability can be much faster than calculating heritability for each
marker.

Using MLM is very similar to using GLM. The difference is that in addition to choosing the joint data set
(or numerical data set), kinship data must also be highlighted before clicking the MLM button to show the
MLM option dialog. The option of “No Compression” is the regular MLM which is equivalent to
“Custom level=1". For data sets with large numbers of taxa, the optimal compression option may be
considerably slower than no compression or user supplied compression. This is because the algorithm
solves the model once for each of a series of compression levels in order to determine the optimal one.

All MLM analyses create two output tables, model statistics and model effects. If compression is used, the
analysis creates three tables.

|£| MLM _statistics_for_Filtered_mdp_traits + Filtered_mdp_population_structure + mdp_genotype_chrl_157104-3706018 &J
Trait Marker Locus Site df F p errordf markerR2 Genetic Var Residual Var  -2LnLikelihood
dpoll None 0 a a 257 a 8.068 14,585 1,477.183|
dpoll PZB00859.1 1 157104 1 0.001 0.979 250 0 8.068 14,585 1,477.183
dpoll PZAD1271.1 1 1947984 1 4.339 0.038 248 0.015 8.068 14,585 1,477.183
dpoll PZA03613.2 1 2914066 1 0.132 0.716 255 0 8.068 14,585 1,477.183| _
dpoll PZA03613.1 1 2914171 1 2.829 0.094 256 0.01 8.068 14,585 1,477.183( "
dpoll PZA03614.2 1 2915078 1 0.044 0.834 243 0 8.068 14,585 1,477.183
dpoll PZA03614.1 1 2915242 1 0.788 0.375 241 0.003 8.068 14,585 1,477.183
dpoll PZA00258.3 1 2973508 1 0.732 0.393 240 0.003 8.068 14,585 1,477.183
dpoll PZA02962.13 |1 3205252 1 0.967 0.326 244 0.004; 8.068 14,585 1,477.183
Anall P7an2aA7 14 1 2IN52R2 1 nno% n ]72 779 n ] NAR 14 GRS 1477 1”3

< »

[ Print | [ Export(csv) | [ Export(tab) |

The statistics table shows the results of the tests for each trait. The first line is for the model with no
markers. Following that is a single line for each marker tested. The columns labeled “df”, “F”, and “p” are
the degrees of freedom, F, and p-value from the F distribution for the test of the marker. The column
“errordf” is the degrees of freedom used for the denominator of the F-test. The column labeled
“markerR2” is the R2 for the marker calculated based on a formula for R2 for a generalized least squares

GLS) model as shown here.
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Rz _ (}; full — ?reduced )T V_l (? full — j}reduced )
(v-v)yrv'(v-7)

The columns “Genetic Var”, Residual Var”, and “-2LnLikelihood” list 62a, 62e, and minus two
times the model likelihood, respectively. When the P3D option is used, all of the values are the same
for a given trait because they are only calculated once. A second table lists the estimated effects of
each allele for each marker similar to the output for GLM. The compression results table shown
below shows the likelihood, genetic variance, and error variance for each compression level tested
during the optimization process. The meaning of groups and compression is discussed above in the
description of the compression method. The compression level with the lowest value of -2LnLKk is
used for testing markers.

r -

|£| MLM_compression_for_Filtered_mdp_traits + Filtered_mdp_population_structure + mdp_...&J
Trait # groups Compression -2LnLk Var_genetic Var_error

dpoll 259 1 1,480.402 7.362 8.145| &
dpoll 248 1.044 1,479.47 7.635 7.81
dpoll 243 1.066 1,479.505 7.656 7.855
dpoll 238 1.088 1,481.049 7.338 8.416
dpoll 234 1.107 1,482.935 6.957 9.069
dpoll 229 1.131 1,483.301 6.904 9.261
dpoll 224 1.156 1,482.597 6.866 9.394
dpoll 220 1.177 1,486.718 6.172 10.576
dpoll 215 1.205 1,485.526 6.407 10.342
dpoll 211 1.227 1,486.045 6.21 10.709
dpoll 207, 1.251 1,488.214 5.897 11.345| ~

< »

[ Print | [ Export(csv) || Export(rab) |
£¥ Gs

3.8 Ridge Regression

This function performs ridge regression to predict phenotypes from genotypes. It is one of the methods
used for genomic selection (GS).

The input dataset must contain one or more phenotypes and numeric marker data. Optionally, it may also
contain factors and covariates. The analysis is run by selecting the input dataset then clicking the “GS”
button. Because no additional user input is needed, the analysis will run immediately after the button is
clicked. All traits will be analyzed separately using all of the genotypes, factors, and covariates in the
dataset. The output will consist of two new datasets for each trait. One of the datasets will contain
genomic estimated breeding values (GEBVs) for each taxon and the other will contain BLUPs for each
marker in the genotype file. The output datasets will appear in the “Numerical” folder, which holds the
input data as well. The output datasets can in turn be used for subsequent analysis. For example, it could
be joined with the input data so that the predicted values could be graphed against the original values.

Understanding the input data requirements is important to ensure that the results of the analysis will be
correct and useful. Genotypes must be numeric with one column for each marker. It is expected that the
markers are bi-allelic, with the homozygotes coded as 1 and -1 and the heterozygotes coded as 0.
However, any reasonable coding scheme will work. For instance, missing data could be replaced by a
probability resulting from imputation. If any genotype data is missing, it will be imputed as the average of
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the marker scores across all taxa for that marker. If a user prefers to use a different method of imputation,
then the missing genotypes must be imputed before importing the data into TASSEL.

GEBVs will be calculated for all taxa in the dataset, including any lines that have missing phenotype data.
A typical use of genomic selection is to predict GEBVs for a set of unphenotyped lines based on the
performance of a training set. To do that a dataset containing both the genotypes to be predicted and the
genotypes of the training set can be joined with a dataset containing the phenotypes of the training set
using a union join. All taxa in the phenotype set should have genotypes. If an individual without genotype
data is included, all the marker data for that individual will be imputed, which is not a generally useful
thing to do.
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4 Result Mode

Results mode consists of the functions to present data as table or graphics.

4.1 Table

Allows data to be displayed in a spreadsheet view and exported into a flat file.

To create a table, select a data set from the Data Tree panel, then click on the “Results” button followed
by the “Table” button (Results = Table). Shown below is an example in which diversity estimates are
displayed.

-
T Diversity estimates
Site_Type = StartSite EndSite Site  SiteCount SegSites Pi Theta Hapl...
Al 0 499 249 |500.0 2 4,1471571906352743E-4  |7.853054255286058. .. [Motavail ||~
All 100 599 349  |500.0 2 4.7396082178688333E-4  |7.853054255286058. .. NotAval |
All 200 699 449 1499,9347826086956 3 0.001253933539122938¢4¢ |0.001178111805050... NotAvail
All 300 799 549 499,9347826086956 4 0.00129741468399504938  |0.001570815740066... NotAvail
all 400 899 649 |499,9347326086956 7 0.0020208359569745516  |0.002748927545116. .. |[NotAvail
All S00 999 749 |499,9347326086956 7 0.0020208359569745516  |0.002748927545116... NotAvail
All 600 1099 849  |499,93478326086956 6 0.002464276341277462 0.002356223610100... NotAvail
All 700 1199 949  |500.0 8 0.0018146201624462499  |0.003141221702114... NotAval |
All 800 1299 1049 |S00.0 9 0.0018580984233158102  |0.003533874414878... NotAvail
All 900 1399 1149 |500.0 12 0.0014381270903010516  |0.004711832553171... NotAwvail
All 1000 1499 1249 |498,7601528905877 17 0.0026352213180236305  |0.006691689460662. .. NotAvail
All 1100 1599 1349 |498.7601528905877 13 0.0021560977308205304  |0.007085318252466... NotAvail
v
< >
[ Print ] [ Export {csv) ] [ Export {tab) ]

Data can be sorted by clicking on the column header of interest. A secondary sort can be done by holding

down the CTRL key and clicking on a second column.

Data can be exported to flat files that are either comma-separated (Comma Separated Values = CSV) or
tab-delimited. Both these formats can then be imported into a spreadsheet program such as Excel. Tables

can also be printed.

4.2 Tree Plot

Displays the results of cladogram analysis.

After running Analysis = Cladogram, select the desired data set and then click Tree Plot in the Results

mode (Results = Tree Plot). Trees can be visualized in either a Normal or Circular layout.
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These images can be printed, saved in JPEG format, or saved as a Scalable Vector Graphics (SVQ) file.

4.3 2D Plot|—= 20Piof

Displays 2D plots and determines color thresholds.

This function is useful for plotting associations in multiple environments.

First, select the desired result set. Using the drop down boxes provided, populate rows with
“Environment,” columns with “Site,” and value with “PermuteP.” The cutoff value for coloring can be

chosen either by inputting a value in the text box or by using the slider tool to the right of the text box.
Users can “mouse over” any box to view the value associated with that box, as shown here:
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T 2-D chart
@ é Q Ay eﬁ ‘ Cell size ‘ 14 | |[] only upper triangle ‘[:] P-Yalue _2]
Row: Environment | v | Column: Site v | Yalue: PermuteP |

Cutoff | 0,001 J Save SVG

PermuteP 18 511 625 880 1000 1459 1490 1570 1618
CLAYTON.ID1S I
HOMESTEAD.ID1 I
Btatistics - Min: 0.0 Max: 0.98 Mean: 0.2658788 SD: 0.32200772 |HOMESTEAD.IDI:1490(0.0) |

If P-value coloring is desired, simply check the P-value box as shown below:

T 2-D chart
@ é E Ay eh ‘ Cell size ‘ 14 |+ |[] only upper triangle ‘ : : @
Row: Environment | v | Column: Site v | Yalue: PermuteP | v

Cutoff Save SVG

PermuteP 18 511 625 830 1000 1459 1490 1570 1618
CLAYTON.ID1S I
HOMESTEAD.ID1 I
Statistics - Min: 0.0 Max: 0,98 Mean: 0,2653788 SD: 0,32200772 [HOMESTEAD.ID1:1459(0.04) |

By checking the P-value box, Cutoff selection tools will be disabled and fields will instead be colored
according to the following grayscale:

Dialog
B oo
© 0.001-0.01

0.01 -0.05

> 0.05

[ OK ] [ Cancel ]

This key can be shown by clicking on the “?” icon next to the P-value check box.

4.4 LD Plot & oPio

Displays the results from the linkage disequilibrium analysis.

After selecting the desired result from the Data Tree panel, click on the “LD Plot” button while in
“Results” mode (Results 2 LD Plot).

The graph that is generated displays LD between all possible pairs of sites. The black diagonal represents
LD between each site and itself. The default setting graphs #* in the upper right and p-values in the lower
left. This default can be modified by clicking on the radio buttons in the lower left. The left side of the
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graph contains a text description of the gene (or chromosome) and the site within the gene (or genetic
position within the chromosome). At the bottom of the graph is a display of the position of each site along
the gene or chromosome. This display can be hidden by deselecting the “Schematic” checkbox. Legends
describing the color scheme appear on the right hand side of the graph.

T Linkage Disequilibrium
Upper R"2
1.00
0.90
d8codings 18 0.80
0.70
décodings511 || 0.60
0.50
_ | 0.40
d8codings625 030
[ 0.20
d8codingsS80 0.10
| 0.00
d8codings 1000 Lower P value
[ >0.01
décodings 1459
<0.01
d8codings 1490
d8codings1570 <0.001
d2codings1618 <0.0001
d2coding
OFE ®r2 OD () Gene View [ Save PG ] [ Print ][ Save SYG ]
. . - . ) ) Close
@P Oz OD () Chromo Yiew Schematic

LD plots can be printed, saved in JPEG format, or saved as a Scalable Vector Graphics (SVG) file. An
SVG file is useful for creating publication quality graphics which can be easily sized using an editor such
as Adobe Illustrator, Corel Draw, or OpenOffice.org Draw 2.0+.

4.5 Chart/ilicnart

Chart provides a variety of graphs for visualizing numeric data.

This feature can be used to display histograms, XY plots, bar charts and/or pie charts. Any numeric table
data can be charted, including LD results, phenotypic data, diversity results, and association results.

Histograms: Use the graph type combo box to select the desired graph type (Histogram) from the list of
options. Up to two different series of data can be plotted together. Users may specify the number of bins

to be used in the histogram.
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Series 1| DPOLLHOMESTEAD. ID1 | [Series 2 DPOLL.CLAYTON.IDIS vins 35
DPOLL.HOMESTEAD.ID1 & DPOLL.CLAYTON.ID15 Distribution
12.5 1
10.0
751
5.0 1 I
l
25 1 I I
0.0 - : : -
o 1 220 3 4 s e 70 80 @0 100 110 120
l. DPOLL.HOMESTEAD.ID1 M DPOLL.CLAYTON.ID15 ‘

Scatter plots: Use the graph type combo box to select the desired graph type (XY Plot) from the list of
options. Select data to be plotted in X and Y axes using the appropriate drop down boxes. If two data
series are plotted simultaneously on the Y axis, the “2 Y Axes” checkbox will provide an axis for each.
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5 Menus

The menus in TASSEL include File, Tools, GDPC, and Help menus. The File menu is mainly used to
save the entire data tree which includes the data loaded into TASSEL and the data created within
TASSEL. A previously saved data tree can be loaded to TASSEL. This function provides the users the
capability to save their intermediate results. The tools menu contains contingency test and option to set
preference.

GDPC (Genomic Diversity and Phenotype Connection) is a software package to retrieve data from open
database sources such as SNPs and phenotypic data. It can also be started using the “GDPC” button in
data mode. Its use is described earlier in the manual.

5.1 File Menu

Individual data sets on the data tree and the entire data tree can be saved. An individual data set is saved
in the genotype format for sequence data or numerical format for phenotype, covariate, and kinship. The
data tree is saved in a binary format.

5.1.1 Save Data Tree

This feature allows you to save the entire contents of the Data Tree panel to a default location. This is
helpful when the user does not wish to recreate a Data Tree panel that is already well populated with
information the next time they initializes the program. To save a Data Tree, select File > Save Data Tree.

5.1.2 Open Data Tree

To restore a Data Tree that was saved previously saved, select File > Open Data Tree.

5.1.3 Save Data Tree As...

To save the contents of a Data Tree to a specific location or to give it a specific name, select File > Save
Data Tree As....

5.1.4 Open Data Tree...

To restore a Data Tree from a specific location, select File > Open Data Tree...

NOTE: The information outlined above for saving a Data Tree is applicable to files that are, in general,
version specific. When a new version of TASSEL is released, a data tree saved with a previous version
might not load to the version. For longer term storage, the best practice is to save individual data sets
rather than the entire data tree.

5.1.5 Save Selected As...
To export data to one of the supported file types, select File > Save Selected As...
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5.2 Contingency Test

T Contigency/Fisher Exact Test

Contigency Or Fisher Exact Test

Rows Columns Reps

2 v |2 v

Enter Data & Hit Calculate

Left-Tailed P:
Right-Tailed P:
Two-Tailed P:

Calculate Cancel

This utility calculates a chi-square contingency test or Fisher exact test (when using only the 2 x 2 table of
observations) using the same algorithm as is used in determining linkage disequilibrium.

5.3 Preferences

The Quality Score Colors tab, found in the Preferences dialog box, allows the user to set cutoff values
for visualizing quality score values on a sequence alignment or a set of called SNPs.

T Preferences

Low Range Cutoff:

J o
-1 9 19 29 39 49 59 69 79 89 99
Middle Range Cutoff: 0-20
High Range Cutoff:
J 2

-1 9 19 29 39 49 59 69 79 89 99

To set a desired threshold, simply adjust the slider on the left side of the dialog. Ns, “-* (dashes), and
alignments without any quality score information have a default value of -1 (minus one).
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6 Tutorial

This tutorial reviews several common scenarios for using TASSEL in order to help the user better
understand its capabilities for data manipulation and association analyses. The TASSEL software package
includes a tutorial data set that can be downloaded from the TASSEL website (please unzip all files to a
directory of your choice). This tutorial data set contains data for phenotype, genotype, population
structure, and kinship.

6.1 Missing Phenotype Imputation

The phenotype file mdp_traits will be used to demonstrate the process of imputing missing data. Note
that the data set below contains missing values (NaN).

|£| TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3.0.37 SRR X
File Tools Help GDPC
E?;:n D... [ 0 Analysis ” @Resulls ] [Delete] [ Wizard ] [ M show Memory ] | 0% | h
Yibh GDPC] [§ Load] [ﬁ F_xpon] [Y Sites] [D- Taxa] [Y Trailsl [w Impute SNPS] -5 Transform: [P'—'q Synonymizer] [.u Join]
= d'§_seguence_d1r_6-2404 || Taxa EarHT dpoll EarDia
"8 Pobmorpiizes 811 59.5 NaN NaN
= |, Numerical : o
e | i
£ Wmdp_traits - - : :
é )\ Matrix 4226 65.5 59.5 32.21933
i - # mdp_kinship - | |8722 81.13 71.5 32.421
= A188 27.5 62 31.419
Table Title: Phenotypes | |A214N 65 69 32.006
Number of columns: 4 =| |A239 47.33 3 36.064
A272 35.63 70 NaN
Number of rows: 301
Number of elements: 1204 - ::::5 g;’: 2;5 3223375 I
AS556 28 65 31.929 i

To impute missing data, first select the mdp_traits data set in the Data Tree Panel and then click the
Transform button (Data = Transform). The “Transform Column Data” window will open. Click on the
Impute tab in this window. Finally, click on the Create Data set button to create the new data set with
missing values imputed.

Note that missing values are now filled.
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TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3037 PR | " i

Byl e @)

[*TW 6DPC| 5} Load| & Export] [T sites| (b= Taxa| (¥ Traits| (3% impute SNPs| [-+5 Transform| [p~q Synonymizer| (@ u Join)

3. JJ Numerical 38-11 92.25 68.5 37.897 -
& mdp_population_structure E) 4226 65.5 59.5 32.21933 =
# mdp_traits 4722 81.13 71.5 32.421
' Wmdp_traits_3_imputed A133 27.5 62 31.419
) Matrix « | |A214N 65 69 32.006
A239 47.88 61 36.064
Imputed Phenotypic Values. # | |A441-5 53.5 67.5 35.008
Taxa with insufficient data: 35 A554 38.5 66 33.41775
K = 30.8% cutoff): A356 28 65 31.929
AB 109.5 80.5 31.5175

A613 36 61 40.63

£
(o | ~ | [n632 50 61 35.953 i

Load !
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6.2 Principal Component Analysis

Principal component analysis (PCA) is a statistical tool that transforms a set of correlated variables into a
smaller number of uncorrelated variables called principal components (PCs). The first PC captures as
much of the variation as possible, and the succeeding PCs account for a decreasing fraction of the
remaining variance. Another application of PCA is to use PCs derived from genetic markers to represent
population structure®. This method requires much less computing time than maximum likelihood
estimation. As most marker data are characters, numericalization must be performed first. A common
approach for converting character marker scores is to set one of the homozygotes to 0, the other
homozygote to 2, and the heterozygote to 1. For haploids, the conversion can be simply performed by
coding one allele as 0 and the other as 1. The TRANSFORM function in TASSEL converts the major
allele to 0. All the other alleles are collapsed to a single class and coded as 1. PCA requires that all
variables should have variation and should not have missing values. As a result, filtering genotype to
eliminate monomorphic markers and imputing missing values may be necessary. Imputing missing values
can be done before or after numericalization. Here we demonstrate how to generate PCs from the
genotype file in the tutorial data.

1. Remove monomorphic sites: Make sure TASSEL is in Data mode. Highlight the genotype
and click Site. Set the minimum frequency to 0.05 and have “Remove minor SNP status”
checked. Click Filter.

2. Numericalization: Highlight the filtered genotype and click Transform. Use the default option
of “Collapse non major alleles.” Click Create data set.

3. Imputation of missing values: Highlight the numerical genotype and click Transform and
then click Impute Tab. Use the default options. Click Create data set.

4. PCA: Highlight the imputed numerical genotype, click Transform, and then click PCA Tab.
Change the default option to “Components=3" by choosing Components and type 3 in the text
box. Click Create data set.
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Three items will be added to the data tree after running PCA. The first are the PCs. The second are the
eigenvalues. And, the last are the eigenvectors. Here we use the Chart Function in the Result mode to
graph the first three PCs, the individual eigenvalue contributions (sometimes called a skree plot) and the
cumulative eigenvalue contributions. The eigenvalues are of interest because they equal the variance
explained by each of the PCs.
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6.3 Estimation of Kinship using genetic markers

While PCs can be used to capture major population subdivisions, kinship can be used to capture more
subtle relationships. This section shows how to create a kinship matrix based on the same SNP data used
to calculate PC’s.

1. Remove monomorphic sites: Highlight the genotype and click Site in Data mode. Set the
threshold on MAF to 0.05, check “Remove minor SNP status,” then click Filter.

2. Estimate kinship: Highlight the filtered genotype and click Kinship in Data mode. A kinship
matrix will be added to the data tree under Matrix category.
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6.4 Association analysis using GLM

We use three files from the tutorial data set to perform association analysis using the GLM. The first file
is the dwarf8 gene sequence with 2466 sites on 91 maize inbred lines. The second one is the population
structure of 282 maize inbred lines. The last one is phenotypes for three traits, for 282 maize inbred lines.
The statistical model is:

Flowering time = Population structure + Marker effect + residual

1.

2.

Remove monomorphic sites: Highlight the genotype and click Site in Data mode. Set the
threshold on MAF as 0.05, then click Filter.

Trait selection: Highlight the phenotype and click Trait in Data mode. Uncheck all the traits
except flowering time (DPOLL). Make sure that the Type is set to Data. Click OK to create a
filtered phenotype.

Covariate selection: The population structure is presented as the proportion of each population.
There are three populations represented as Q1, Q2, and Q3. They sum to 100%. This creates
linear dependency if we use all of them as covariates. We can eliminate the dependency by
removing one of them. In this demonstration, we exclude the last one. Highlight the filtered
phenotype and click Trait in Data mode. Uncheck the last population (Q3). Make sure that the
Type is set to Covariate. Then click OK to create a filtered population structure data.

Joining data: Highlight the three filtered data sets by holding the Control key while selecting
the individual data. Then click Intersection (M) Join on Data mode to create a combined data
set.

Association analysis: Highlight the joint data set then click GLM in Analysis mode to perform
association analysis. Two reports will be added to the data tree.

3
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Filter Alignment
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Extract Indels
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[ Fitter Cancel
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One of the reports added to data tree is labeled “GLM_Marker Test ” followed by the name of the joint
data. In addition to the information for traits and markers, the data set contains the following statistics:

marker F: F value from the F test on marker;
marker p: P value from the F test on marker;
markerR2: R? for the marker after fitting other model terms (population structure);
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markerDF: Degree freedom of marker;
markerMS: Mean square of marker;
errorDF: Degree freedom of residual error;
errorMS: Mean square of residual error;
modelDF: Degree freedom of model;
modelMS: Mean square of model.
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Clicking “marker p” will sort the table by P value. The smallest P value is 1.1021x10™* for SNP at
position 6. The threshold is 5x10 at a significance level of 1% after Bonferroni multiple test correction
(0.01/20). The denominator in the Bonferroni correction is the total number of SNPs tested. The
association was significant.

The other data added to the data tree is labeled “GLM_Allele Estimates ” followed by the name of the
joint data. For the most significant SNP at position 6, there were two genotypes (CC and GG). There are
62 lines with genotype CC and 10 lines with allele GG. For the trait dpoll (days to pollination), the
difference between the two homozygotes was 6.63755 days.
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TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3.0.39

File Tools Help GDPC

&ﬁ:Data ][ onnalysis ] Results ] [Delete] [

Wizard

]

[ M show Memory ]

(EEEE Table | [\ Tree Plot

7% 20 Plot] [Tl LD Plot (g Chart]

[>

----- ® SNP Assays A Trait Marker Obs Locus Locus_pos  Allele Estimate
---- *® LD dpoll 6 62 6[C 6.63755
=) Association dpall 3 10 66 0
- @ GLM_marker_test_Filtered_mdp_ dpoll 9 49 alT 1.44879
dpoll 9 23 9lc 0
----- dpoll 24 15 24/C 3.10862
""" dpall 24 59 24/G 0
< | > dpoll 28 1 28/- 9.23009
dpoll 28 62 23[T 6.76409
< | > l dpoll 28 1 28C 0
~ | |dpoll 40 17 40/C 3.27583
Load NRREE— [dpall 40 61 40/G 0
| |dpoll 61 18 61/G 3.25231
Traits LLLLL BN ] 61 62 614 0
dpoll 66 30 66/C -1.2317E0
Sites LLLLL B ] 66 50 66[T 0
dpoll 31 29 31a -1.3196E0
Traits NRNRN | [dpoll 31 51 381G 0
dpoll 229 6 2291 2.84783
N Join NERNE | dpol 229 77 229C 0
dpoll 452 73 452|C 6.16275
GLM [WNNRN & [dpol 452 10 452(T 0
¢ T s | |dpol 754 69 7547 -2.3769E0
ogram Status
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6.5 Association analysis using MLM

Running MLM in tassel is similar to running GLM. The difference is that in addition to the joint data (or
numerical data), MLM requires kinship data to define the relationship between individuals. The kinship
matrix times a parameter equals the covariance matrix between individuals. Here we use kinship file from
the tutorial data set to fit the following statistical model.

Flowering time = Population structure + Marker effect + Individuals + residual
Individuals and the residual are fit as random effects. The other terms are treated as fixed effects.

With respect to the marker effect, we will demonstrate the analysis using two sets of markers. One is the
dwarf8 gene sequence used in the GLM tutorial. The other is a set of 3093 SNPs spread across the maize
genome.

For the dwarf8 gene sequence, use the joint data set created by following the tutorial for GLM. Solve the
mixed linear model by highlighting the joint data set and the kinship data then clicking the MLM button
in Analysis mode.

| ) TASSEL (Trait AnalysisW_

File Tools Help GDPC — -
[_Eﬁ:n Data ” °Analysis ]@ Results ] [Delete] [ Wizard l [ M Show Memory ] [ 0% n@

| Diversity | [Tl Link. Disea.| [ Cladogram| (% NP Extract| [*7° Kinship| |¥¥ 6Lm| ([ 5] mLm]

) Data # || Taxa dpoll Q1 Q2 Haplotype

G- igé Sequence 38-11 68.5 3.0E-3 0.993 NNC-CGCAT... ~
® d8_sequence A272 70 1.9E2 0.122 CTGTGATGC... F

# mdp_genotype A441-5 67.5 5.0E-3 0.531 CTGTGATGC...
~® mdp_genotype - | [As54 66 1.9E2 0.979 CTGTGATGC... =

' : ;“:psf::’:::epem 62404 | |ae 30.5 3.0E3 3.0E-2 CTGTGATGC...

- S 2619 61 5.0E-3 0.95 GCGCGACA...

ML Aered_mdp_traits -+ Fitered_mdp_populsSop vee 61 0.993 4.0E-3 CTGTGATGC...

@ Polymorphisms B103 57.5 0.163 0.829 CTGTGATGC...

&34 Numerical ) — | |p104 64.5 0.694 0.305 CTGTGATGC...

# mdp_population_structure B14A 63.5 0.998 1.0E-3 CTGTGATGC...

# mdp_traits ) B37 65.5 0.997 2.0E3 CTGTGATGC...

- o F!Itered_mdpJaoF:uIahon_structure 863 715 0.038 1.0E3 CTGTGATGC...

~ @ Filtered_mdp_traits B73 70 0.999 1.0E-3 CTGTGATGC...

g Matrix B34 67.5 0.9%6 3.0E3 CTGTGATGC...

JRip-kinshio B97 0.5 1.6E2 0.981 CTGTGATGC...
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| %| MLM Options [

Compression Level

") Custom Level:

| (7) No Compression
| Variance Component Estimation

@) P3D (estimate once)

‘4 *) Re-estimate after each marker
|

Run Cancel Help Me Choose

A =

An MLM option dialog will pop up as shown above. Choose the default options, which use P3D and
compression at the optimum compression level. After the Run button is clicked, the progress bar will start
moving. The time required will depend on sample size, number of traits, number of markers, and the
options chosen in the MLM option dialog. After the progress bar is reset to zero, indicating completion of
MLM, three reports will be added to the data tree. The first two are similar to the reports created by GLM.
The most significant SNP is still the same, however the strength of association is weaker, with a P value
of 7.139){10’4 (vs. 1.1021x10™* from GLM) which does not pass the Bonferroni multiple test threshold
(5x107).

The third report contains the MLM specific statistics, including -2 Log Likelihood, genetic variance and
residual variance components under different level of compression. These statistics are illustrated by the
Chart function on the Result mode as follows.

r @ N 5 ™y
(&) . = - | () - =ARCE X
Graph Type: XYScatter v Save Properties Graph Type: XYScatter - Save Properties
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480
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|
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In the example, 79 are included in the final analysis. When they are clustered into 44 groups, the -2 Log
Likelihood reaches a minimum, which indicates the best model fit. The screening of SNPs was performed
at this optimum compression level.

Note: When two or more individuals are clustered into one group, the variance component for the random
effect is not equivalent to the one without compression. Consequently, the heritability derived should not
be interpreted as the individual based heritability.

To perform a Genome-Wide Association Study (GWAS) on the 3093 SNPs, we need to create a new joint
data set containing the filtered phenotype, population structure, and the genome—wide genotype. Highlight
the new joint file and the kinship data and click the MLM button. Choose the default options on the
MLM option dialog. The analysis will take a minute or two. The output report labeled
“MLM _compression” indicates that 259 lines were used in the analysis. With 74 groups, the statistics
from the best are as graphed below.

r N 7 B
2 - » [E=REER) y fF - [E=REER
= o= - - - . -
(Graph Type: XYScatter - Save Properties (Graph Type: XYScatter - Save Properties
Y1 |i-2lnLk i w| Y2 None - Y1 |Var_genetic w | Y2 |Var_error -
X | ¥ groups b | Line | Regression [F12Y Axes X ¥ groups hd [¥] Linet | Regression 12Y Axes
# groups vs. -2LnLk # groups vs. Var_genetic and Var_error
1517.5
B 22
15150 { 9
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g 14
1500.0 o ]
™~ <] £ 13
2 14975 By S 12
| (=] 11
! 14050 5
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3 6
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§
14825 ¥ <
5 3
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1477.5 » 1
0
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= -2Lnlk [ var_genetic —var_error|
== — L = —

The strongest associated SNP is at 193565357 bp on chromosome 3. The P value is 1.3027x10. The
threshold is 3.2331x107 at significant level of 1% after Bonferroni multiple test correction (0.01/3093).
The association was not significant. As illustrated below, the output labeled “GLM_Allele Estimates”
shows the marker effects assigned to genotypes for each SNP (The GLM is also the same). For example,
the first SNP at 157104 bp on chromosome 1 had three genotypes (AA, CC and AC) coded as A, C, and
M based on the IUPAC code, see Appendix (Nucleotide Codes).
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|%| TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 3.0.39 I E@Q
A S— .
File Tools Help GDPC
ioznata || @ Analyss || [dResuts | [Detete| | wizard | | I ShowMemory | L o% 4 n@
| Table| [ Tree Piot| |72 2D Plot| i, LD Piot| [l Chart|
® Tree A | | Trait Marker Locus Site Allele Effect Obs
# Fusions dpoll PZB00859.1 |1 157104 c 3.64912 197 ~
i SIV"°“V""ZE' dpoll PZB00859.1 |1 157104 A 3.60484 53 =
Ji Resuit dpoll PZB00859.1 |1 157104 M 0 3 f
- ® Diversity dpoll PZAO1271.1 |1 1947984 C “1.2325E0 121 |
- ® SNP Assays dpoll PZAD1271.1 |1 1947984 G 0 127 i
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r @ MM _statistics_for_Fitered_n[ g 1575 PZA03613.1 |1 2914171 [T 5.20917 195 I
. MLM-‘°"‘P“?SS";2—@:—F“°E'& | [aoi PZAD3613.1 |1 914171 |A 6.46891 61 i
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§) | Filtere | |apol PZA03614.1 |1 215242 A 0 111
dpoll PZA00258.3 |1 2973508 G 2.7856E0 65
Table Title: MLM effects “ dpoll PZA00258.3 |1 2973508 C -3.3585E0 175
B =
Number of columns: 7 dpoll PZA00258.3 |1 2973508 s 0 2
- , SO ~ | |dpol PZA02962.13 |1 3205252 [T 2.1007E0 218
<[] r dpoll PZA02962.13 |1 3205252 |A 3.2237E0 26
—7 |dpol PZA02962.13 |1 3205252 W 0 3
Load (i | |dipol PZA02962.14 |1 3205262 |C 2.0366E-1 224
dpoll PZAD2962.14 |1 3205262 |G 0 15
Export \ dpoll PZA00599.25 |1 3206090 C 0.61187 26 |
dpoll PZA00599.25 |1 3206090 [T 1.28776-1 231
Transform | — dpoll PZA00599.25 |1 3206090 Y 0 1
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| n | 4 dpoll PZA02129.1 |1 3706018 c 0 131 -
Program Status J
— o

6.6 Importing Data from a Database (via GDPC)

GDPC, middleware that is integrated into TASSEL, allows the user to import data from a database. To
display GDPC in TASSEL, click on the GDPC button in Data mode. General rules for working with
databases include: 1) Establish a connection with the database; 2) Define a query; 3) once the desired data
is in GDPC, load the data from GDPC into TASSEL.

6.6.1 Connecting with a Database

To establish a connection with a database, click the Add Conn button followed by the button of the
database you wish to add. Then click Ok. In the example below, we chose Panzea.
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wution, and Linkage) 3.0.36

Deletel [ Wizard | B Show Memary | o Egm

(il 6opc| (5} Load] (& Export] (T Sites| b= Taxa [V Traits] [ impute ShPs| [+5 Transtorm| [++q synonymizer| (@ u Join] (@)  Join|

= [ d | B ‘ - I E
Open... Save As Add Connection... Load | Get Started
T

Experiments )
| Connectons | Lag

Taxa |
Ernvranment Experiments Plaags sebart the data source from which vou
Managed Data weould ke bo retrieve dats and dick Ok

;¢m Maize Diversity
IG'M Rice Diversity
[Gramene Wheat Deversity
ianiu Diversity
;Sbrﬂ'um Diversity

Leaiiy]

Humber of columns: 278
Humber of rows: 277
Humker of elementa: 77004

To connect to more than one database, simply repeat the process outlined above.

In the figures of following sections, only the GDPC area will be displayed if other areas are deemed
irrelevant.

6.6.2 Data Query

GDPC is equipped with several tabs to query data, namely Taxa, Taxon Parents, Loci, Genotype
Experiments, Environment Experiment, and Localities. Within each tab, any retrieved data will be
displayed in the “Filtered List.” Choose attributes by checking the desired boxes (located beneath the
Filtered List). After an attribute is selected, values of that attribute from the database are displayed.

Here, using the Taxa tab, choose Germplasm type (field) and then select. After clicking the Get Data
button, the subset of taxa from the database that meets these criteria will appear in both the Filtered List

and the Working List.
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N— P\ J > J J T J J J =

B

Open  Save As... Export... GetData Load... Deselect all Add Conn Load Get Started
Taxa [Loci Genotype Experiments | Environment Experiments | Localities | Genotypes | Phenotypes | Connections | Log
Filtered List {5315) 1% i wWorking List {(5315) 1% i H A Pn
[=)-Accession ~ [=)-Accession ~ jaco
-33-16 = #-33-16 =
#-38-11 #-38-11
#4226 #4226
#4722 #4722
w-81-1 & w-81-1
#-A158 #-A158
#-A188 -A188
w-8214N > w8214
[+-A239 [+-A239
#8272 #8272
44415 [ 44415
#-A554 #8554
[-AS56 #-AS56
86 Ej...gé
#-A619 ®-A619
i #8632 #8632
T #-A634 v #-A634 v
< > < >
[[] Genus ) Locality {working list) Germplasm Type
. BC hybrid
| fpecles Hybrid
[ g L
Germplasm Type Open pollinated
. Teosinte
[ Accession Teosinte inbred
[[] Accession Mumber Tripsacum
[ Source

Items listed in the Working List can be modified by the user. To do so, first break the link between the

)
Filtered List and the Working List by clicking on the Link/Unlink button . The button will now

ol &Y
appear as . This activates the Add selected items ; , Add all items = , Remove -

and Remove all “* buttons. Remove all items from the working list, then select items with a name
starting with the letter D. Click on the Add selected items button to move them to the Working List. The
resulting Working List is shown as follows:

Taxa ‘ Taxon Parents || Loci H Genobype Experiments H Environment Experiments || Studies H Localities \|E
Fitered List (10531) % % wiorking List (86)  [% W (%
e (1) ~ =-Mame (25) Al

[#-D146 (1)

Do40v (27) |

DEL (11)

DEZ2 (1)
DE3 (1)
E DE&LL (11}
-DE_2 (10)
RO 75004 (1) v #-DE_3(7) L
< > < >
[] Accession | Locality (working list) Germplasm Type
[[] Genus
[[] species Inbred developed from wild
[[] subspecies Matural
Segregating Population

Germplasm Type Traditional cultivarflandrace
[] Accession Mumber wild
[] source
[ Lacality
[] collectar
—_- .
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To filter data by polymorphism type, first click on the Genotype Experiments tab, check the
Polymorphism Type and Producer checkbox (field), and then select SNP and Jim. Finally, click the
Get Data button to reveal the subset of data that meets these criteria. Results for this example are shown

below:

Emnvironment Experiments |/Studies |’Lucalities rGenutypes rPhenutypes |’Cunnectiuns rLug |

Taxa

Taxon Parents

Loci r

Filtered List (693) H

Working List (693)

Genotype

Propert
Froducer

¢ Mame (E33)
o= PHM10225.15 (1)
o= PHM10321.11 (1)
o PHM10404.8 (1)
o= PHM10525.11 (13
o= PHM10525.9 (1)
o PHM10750.26 (1)
o= PHM11000.21 (13

1

[

ol

¢ Producer {1}

o= _lirn Halland (B93)

| »

-

1

[+

Polymorphism Type
[] Name

[]Locus

["] string Representation
[] Source Experiment
Producer

[] Align Program

[L] Primer List

[] Reference Seq e

|| Locus (working list) Polymorphism Type Producer

Categorical Genaissance =

Length Goodman

SNP lllumina

Sequence Jim Holland |
McMullen
PHI i
Pioneer I
Sequenom
Ware ~|
< T Dl |

Genotype data can be extracted from the database by clicking on the Genotypes tab, followed by the Get
Data button. After a moment, genotype data will be displayed as follows:

| Environment Experiments | Studies | Localiies | Genotypes | Phenotypes | Connections | Log |

Taxa Taxon Parents Loci Genotype Experiments
PZAN3I0GT7 4| PZADI0S2 T PZADI0S0. 31| PAADI0AS. T PZADI0AT 17| PZADI0R4.6 PZADI0G3.1 8] PZADI0GA2. T PZADI04T 1 2PZA

DJ7 T.C TT TT TT i A, TT i A, GG [~
DK2MAZ22 [ TT TT TT TT GG TT TT GG GG|
DKAGTGA TT TC TG TT TC GG T:C i A G|
DK78002A T.C TT TT TT ZiC GG TT TT AR, GG
DK78004 TT TC TG TT TC - CiC TC - --
DK78010 TC TT TT TT [ GG TT TT A G|
DKT8371A TT (SN T.G TT GG TT i [EXE] A

Taxa (working list)

Genotype Experiments (working list)

Do2
D146
D940Y
D940
D940Y
D940
D940
D940
D940
D940Y

PHM10225.15
PHM10321.11
PHM10404.8
PHM10525.11
PHM10525.9
PHM10750.26
PHM11000.21
PHM11114.10
PHM11114.7
PHM112.8

1]

1]

Users can either save this genotype data in several formats or upload it to TASSEL. However, before
outlining these procedures, let us finish the query by exploring phenotypes. To get data from experiments
conducted in 2000, first select the Environment Experiments tab, followed by the Repetition checkbox.
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Select the desired repetitions in 2000 as the values to be used for filtering, then click the Get Data button.

The subset of data that meets these criteria is returned as follows:

F

Environment Experiments |  Studies | Localities | Genotypes | Phenotypes | Connections m

Taxa I

Taxon Parents

Loci I

Filtered List (369)

Working List (369)

=l

38-11 Row_2000_Winter

38-11 Row_2000_Summer
38-11 Row_2000_Summer_B10
38-11 Row_2000_Summer_C2
A272 Row_2000_Summer

AZT2 Row_2000_\Winter

AT Row_2000_Summer_C2
Adda1-5 Row_2000_Summer_B10

{ i

[

Ly

9 Locality (3)
o= 27 Farms (95)
& Clayton {186)
o= YWest Lafayette (84)

4

| »

[ Locality

[_] Bvaluation Site
Repetition

[]Block

[1PIot

[] Plant Date

[] Coordinate X

[] Coordinate Y

[_] string Representation

Locality (working list)

Repetition

2
2000_Summer
2000_Summer_4F8
2000_Summer_B10 =
2000_Summer_C2
2000_Winter
2001_Summer_F4A_Re
2001_Summer_F4A_Re__|

4 I [ ¥

a|

Now extract phenotype data by clicking on the Phenotypes tab. Traits can only be extracted one at a time.
Choose Days to Silk from the Ontology field. Make sure no Taxa are selected and all Environment
Experiments are selected that were retrieved in the previous step. Click the Get Data button, then the
Merge button, leaving only Accession checked under the Taxa Properties section. Leave Locality and
Repetition checked under the Environment Experiments Properties section. Data are merged as follows:

Environment Experiments |  Studies | Localities | Genotypes | Phenotypes ra
Taxa I Taxon Parents I Loci
Merge Function: =
27 Farms_...|CGlayton_20...| Clavton_20.. | Clayton_20...
38-11 65.0 42.0 5.0
A272 53.0 g4.3
Ad441-5 6E.0 92.0 730
A554 2.0 G2.0
A6 78.0 104.0 ar.25
AG19 54.0 G7.0
AG32 45.0 G7.0
B103 53.0 3.0 T4.0
B104 670 1.0
Ontology Taxa (working list) Environment Experiment...
Cupules per rank | |poz || |38-11 Row_2000_Wint:
Days to Pollen || |p146 |=| [38-11 Row_2000_Sum
Days to Silk '=| D940y 38-11 Row_2000_Sum
Days to Silk DO40Y 38-11 Row_2000_Sumi
Days to Tassel Do40Y A272 Row_2000_Sumi
Ear Diameter D940 A272 Row_2000_Wint,
Ear Height D940 A272 Row_2000_Sumi
Ear Length D940Y A441-5 Row_2000_Su|
Ear Number - | (D940Y A441-5 Row_2000_Win _|
F] Il | » |_ Do40Y

6.6.3 Importing GDPC data into TASSEL

Genotype and phenotype data must be loaded in separate steps. To load genotype data, first click on
GDPC in Data mode. Then click on the Genotypes tab, followed by the Load button. The genotype data
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is then loaded into TASSEL and labeled as “Genotype.” To view the uploaded data, click on “Genotype”
within the Data folder in TASSEL. Results will look as follows:

TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 2.1
File Tools Help GDPC
[_Eg"?}:u Data ][ °Analysis ] @Results ] @
[22] P T sttes) (b= Taxa) [A:a | s ] izer| (@ u Join] (@ n Join
) Data | [Taxa PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA... PZA...
T..# Sequence y 4 7 3 7 17 6 18 7 2 14 6 5 23 16 7
53 Polymorphisms ID18...ID18...ID18...ID18...ID18... ID18... ID18... ID18...ID18... ID18... ID18... ID18...ID18... ID18... ID18...
5 [5) PZA3097.4.ID18566 D17 nC T T T GC jAA T G &AL GG |GC G666 T GG A
Y DK2MA22 GC T T T T @6 T T &6 |GG |GG |GG &G |[GC |GG
@ Numerical DK46764 T nC N6 T nC &6 TC G &G A6 |GG |- GG TiC |-
@ Matrix DK780024 TC T T T G &6 T T jAA |GG |GC Gi6 [&G |[CC |AA
L Tree DK75004 T nC TG T TC |- CGC iC |- Sie G - @G TiC A
.. Fusions DK78010 TwC T T T |GC &6 T T &A &6 |GC |Ge &G TiT [AA
L. Synonymizer DK78371A LEL = LE I T &6 [T |GC &6 [AA GG |GG |GG |GC |GG
) Result DKFAPW T T T T |GC &6 T |GC A &6 |GG |GG |GG |CC GG
DKFBH] T |GC T T G &6 T |GC A |AA GG GG GG |G |AA
DKHBAL -:- TT T T nC AA T G @6 AA &6 &6 |GG |GC GG
DKIEO14 CGC |cC T T e AA T T &6 |AA |GC GG &G |[GC |GG
DKIBOZ CGC T T T - AA T T - GG &6 |GG &G |GC A6
DKMBNA LELI =t e T T |- -i- -i- GG A |- GG |- CC o |AaA
DKMBST T |GC T T - -i- T:T  |GC |- GG |- GG |- C:C (GG
DKMDF-13D - T T T |GC &6 TT |GC &6 A &6 |GG |GG TiT |-
DKPESO T T T T G AA T |GC AR AR GG GG |GG T |AlA
v
v
il El| B3 >
Program Status

To load phenotype data from GDPC into TASSEL, first click on the GDPC button in Data mode. Then
choose the Phenotypes tab, followed by the Load button. The phenotype data is then loaded into
TASSEL and labeled as “4 traits/environ.” To view the uploaded data, select “4 traits/environ” from
the Phenotypes folder in TASSEL. Results will appear as follows:

TASSEL (Trait Analysis by aSSociation, Evolution, and Linkage) 2.1
File Tools Help GDPC
G — 5
[_:gg;g Data ][ ° Analysis ] @ Results ] @
[22] P T sttes) (b= Taxa) [A:a | s ] izer| (@ u Join] (@ n Join
) Data | [Taxa Days...Days...Days...Days...
L..® Sequence u 27 F... Clay... Clay... Clay...
(=) Polymarphisms
2 e s = 0 fou oo oo »
1P oy aenctype 4415 65.0 [N [73.0 [92.0
4 traitsfenviron ASS4 52.0 |62.0 |MaM |MNah
@ Matrix A6 78.0 |NaM |87.25 |104.0
e Tree AB19 54.0 |NaN |67.0 |MNaN
\..# Fusions AB3Z SS.0  |NaN  |67.0 |MaN
L..# Synonymizer B103 53.0 |74.0 |MaN |73.0 L3
) Result B104 67.0 |NaN |71.0 |MNaN
B144 58.0 |NaM |72.0 |79.0
B37 60.0 (98.0 |MaN |76.0
B68 65.0 (98.0 |MaN |83.0
B73 63.0 [84.0 |MaM |MaN
B34 65.0 |Nal |74.0 |NaM
B97 S6.0 |NaN |69.0 |MNaN
C103 62.0 |NaN |74.0 |Mah
CI187-2 72.0 |NaN |75.0 |91.0
CM105 S3.0 |61.0 |MaM  |Mah
CM174 48.0 |NaM |S2.0 |NaM
M7 43.0 [S5.0 |MaM |Mah
¥ |cmLio 65.0 |NaM |93.0 |110.0
CML247 75.0 |NaN [89.0 |111.0
CML254 75.0 |NaM  |119.0 NaM
CML258 68.0 |NaN |94.0 |MNaN
CML261 64.0 |Nal |94.0 |NaM
CML277 65.0 |NaN [88.0 |102.0
CML281 68.0 |NaN  |MaM  Mah 3
| 3|« >
Program Status
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6.6.4 Saving GDPC Query Results

All query results, including both genotype and phenotype queries, can be saved as either Tab-delimited
text files or XML files. Results are exported as tab-delimited text files by first choosing the Query Tab

d i)
and then clicking on the Export button E® or by clicking the Save As button 2" {0 save
results in XML format. Location and file name must be specified in both situations. Data in XML format
=
Open

can be imported back into GDPC by clicking on the Open button
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7 Appendix
7.1 Nucleotide Codes (Derived from IUPAC)

Code Meaning

A AA

C C:.C

G G:G

T T:T

R A:G

Y C:T

S C:G
\W4 A:T

K G:T

M A:C

+ +:+ (insertion homozygous)
0 +:-

- -:- (deletion homozygous)

N Unknown
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7.2 TASSEL Tutorial Data sets

The data set contains 9 files and can be downloaded at:
http://www.maizegenetics.net/tassel/docs/TASSEL TutorialData3.zip

File# [File name Type Format

1 d8 sequence.phy Genotype Phylip Alignment

2 mdp_genotype.hmp.txt Genotype Hapmap Alignment

3 mdp_genotype.flpjk.geno Genotype Flapjack Alignment

4 mdp_genotype.flpjk.map

5 mdp_genotype.plk.ped Genotype Plink Alignment

6 mdp_genotype.plk.map

7 mdp_kinship.txt Kinship Numerical square matrix
8 mdp_population_structure.txt |Population structure |Numerical trait data

9 mdp_traits.txt Phenotype Numerical trait data

File #1 is the sequence of dwarf8 gene with 2466 sites on 91 maize inbred lines. The data was described
by the paper on the association between Dwarf8 and flowering time™.

File #2-6 are 3093 SNPs on 281 maize association inbred lines. The data was presented in three formats
(Hapmap, Plink and Flapjack). The data was created by the PANZEA project funded by NSF. Details of
the data can be found at http://www.panzea.org.

File #3 and 4 are in pair for the format of Flapjack.

File #5 and 6 are in pair for the format of Plink.
File #7 is kinship created by Yu et al.’.
File #8 is population structure of 282 maize inbred line®’.

File #9 is phenotype on three traits, including flowering time, on 282 maize inbred lines’.
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7.3 Biography of TASSEL

2001
December, 2004

February, 2005

March, 2005

April, 2005

June, 2005

October, 2005

January, 2006

March, 2006

September, 2006

October, 2006
September 2007
April 2008

June 2008

First public release

Score-able SNP Extractor
Updated Main Panel

StepClade update

Fixed handling of ?s and non-standard characters
Added Sliding Haplotype functionality
Changed LD Fisher’s Exact p-value to use two-sided p-value

Added Ability to visualize sequence quality scores
“Synonymize”/match taxa names between data sets
GLM analysis improvements

Code change preventing large data sets from being shown in JTable

Update of GDPC which allows automatic restoration of last data source

connection

Data transformation utilities added
K-Nearest Neighbor Data Imputation added

Association analysis with Mixed Linear Model
Taxa name " synonymizer" added

Basic heterozygosity handling added

Many ease-of-use improvements

Fixed problem loading genotype data
Mixed Linear Model changes:
*  Output NaN if non-converged
* Fixed problem loading genotype data
* Detection of duplicate ID in kinship
¢ Correction on progressive bar with MLM
* Starting values of NaN from previous marker are no longer used

MLM: Significant speed improvement (~10x faster)
GLM: Added User-defined F-tests, Output taxa or marker means

Principle Components Analysis
Architecture restructure and pipeline version for advanced users

Genetic marker data numerical transformation

MLM implemented P3D algorithm, increased speed in order of magnitude

66



of at least ten times.

May 2009 EMMA implemented

November 2009 TASSEL Version 3 release (redesigned for large genomic data and large
samples)

April 2010 Compression of MLM implemented
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7.4 Frequently Asked Questions
1. What do | do if TASSEL misbehaves?

A: TASSEL is an open source software project hosted on SourceForge and has a bug tracking list at
http://sf.net/projects/tassel where you can notify the developer community of problems. In order for a
bug to be fixed, we must be able to replicate the problem. Thus, it is important to document the steps
that were taken that produced the error. If the data you are working with is not too sensitive, please
include the files which were used in the faulty procedure. If you would rather not post your data file on
SourceForge, you may email it to one of the software developers.

2. Where do | turn for more information?

A: If you are having difficulty with a certain aspect of TASSEL, you can either email one of the software
developers listed at www.maizegenetics.net or you may check the TASSEL forum on SourceForge
http://sf.net/projects/tassel), as another user may have already addressed a similar question. There is
also a TASSEL discussion group at http://groups.google.com/group/tassel.

3. How do | join the fun: TASSEL on SourceForge?

A: TASSEL is an open source project distributed under the GNU general public license. This means that
the source code is available and the user is free to modify the code to suit their particular needs. We
welcome input from developers and those who wish to become involved in the improvement of this
software. The project is hosted on SourceForge (http://sf.net/projects/tassel), thereby allowing anyone
to access the most recent changes to the code. This setup makes it convenient for anyone to add special
functionality to TASSEL if they so desire. It also serves as a good platform for anyone who wishes to
become involved in a bioinformatics software development project.

4. How do | change the amount of memory used? What do | do when the
“Exception java.lang.OutOfMemoryError” appears?

A: If you are working with very large data sets or are running memory intensive procedures, there may be
occasions when TASSEL runs out of memory. For most routine usage, however, TASSEL memory is
sufficient. Memory issues usually result from attempting to execute a procedure like LD on a raw
sequence alignment instead of selected SNPs. You may also experience a memory issue if you are not
sufficiently specific when retrieving information through GDPC. By default, TASSEL is allocated up
to 512 Mb of memory on your computer. If more is available on your computer, you can increase the
amount allocated by downloading the “stand-alone” version of TASSEL and opening a command line
window (in Windows use Start > Run and type in “cmd” or “command”). To run TASSEL from a
command line, “cd” to go to the directory containing the stand-alone jar file then start TASSEL by
typing the following:

java -Xms256M —Xmx768M —jar sTASSEL jar
Where “-Xms####M” specifies the starting memory available and “—Xmx###M” specifies the
maximum memory available to the Java Virtual Machine. You may set the values higher or lower as

your hardware dictates. Alternatively, you can modify the start tassel.bat or start tassel.pl file that
comes with the standalone distribution.
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5. When | click on the most current version of TASSEL web start, a previous
version appears. What should | do?

A: The previous version of TASSEL web start was cached in your machine. To replace it with the most
current version, click the Start button in Windows, followed by Run. Type javaws and then click OK.
In the window that opens, keep the most current version of TASSEL and delete the rest.

6. What should | substitute for missing values in TASSEL?

A: For numerical data in version 3 format, use NA or NaN. For numerical data in version 2 format, use “-
999” for missing values. For SNP data, use “N”. For SSR data, use “?”. Kinship does not allow
missing values.

7. Is it possible to change data names in the Data Tree?

A: Yes. Click on the desired data name in the Data Tree, wait for one second, and then click it again or
immediately hit the F2 key. Rename the data set and then hit Enter to save the change.

8. How can | create a TASSEL icon on desktop?

A: Click “Start” on Microsoft Windows and select “Control Panel”, then double click Java to show “java
Control Panel”. In “Temporary Internet Files” section, click “View” button show “Java Cache
Viewer”. Move mouse over TASSEL application and click right button and select “Install Shortcuts”.

9. Why do | get empty squares in MLM association analysis?

A: The empty square means null information. The major reasons include non-convergence in the
estimation of variance componentsor that the statistic in question was not calculated. For example,
marker F, p, and R? are not calculated when no marker is included in the model.

10. Why should | exclude one column of the population structure?

A: For some methods of calculating population structure, such as the software STRUCTURE, the
population proportions sum to one. This produces linear dependence between the population
covariates. While the algorithm used by GLM tolerates that dependency, MLM will fail because the
design matrix will not be invertibleExcluding one column eliminates linear dependence between
columns. Using PC axes to represent population structure does not result in linear dependency
because all PC columns are guaranteed to be independent.

11. Can kinship replace population structure?

A: Sometimes. For some traits and populations, the K-only model may be as good as or better than the
Q+K model. For others, Q+K may be superior. The Q-only model is not as effective for controlling
population structure as the alternatives. Unfortunately, no general guidelines exist for predicting which
model will perform best. As a result, an investigator may wish to fit all three models and compare the
results. If eliminating false positives is very important, then it may make sense to accept the most
conservative model. However, if the objective is to identify candidates for further study and the cost of
following up on a false lead is low, the most liberal model may be preferred.
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12. Why do TASSEL and SPAGeDi give different kinship estimates?

A: First, many algorithms exist to calculate kinship and their estimates will differ from one another.
Secondly, the algorithm in TASSEL treats each genotype as a haplotype. It is not recommended that
TASSEL be used to generate a kinship matrix from heterozygous genotype. In the near future, the
TASSEL kinship algorithm will be modified to handle heterozygous diploids.

13. Can | get Marker R square using SAS Proc Mixed or TASSEL MLM?

A: SAS Proc Mixed does not produce an R” statistic. MLM in TASSEL does. The user manual
describes how it is calculated.

14. Does MLM find more associations than GLM?

A: Sometimes. MLM has higher statistical power than GLM and may detect more true associations..
When the tested genetic markers are confounded with kinship structure , GLM does not correct for
that as effectively as MLM and may produce more false positives

15. Do | need multiple test correction for the p value from Tassel?
A: Yes.

16. Can TASSEL handle diploid genotype data?

A: While TASSEL accepts most common sequence alignment formats which handle polyploid
genotype data including haploid and diploid, some analyses are not appropriate for heterozygous data.
GLM or MLM fit SNPs one at a time, treating each distinct genotype as a separate class. This has the
effect of fitting an additive plus dominance model. Separating the two effects is under consideration.
Because handling heterozygotes as a third marker class is not appropriate for kinship or LD those
analyses should not be used for that type of data at the present time. Work to improve handling
heterzygotes is ongoing.

17. How to cite TASSEL?

A: The paper that describes TASSEL' as a software package and the papers that introduce specific

methods implemented in TASSEL should be cited as appropriate, such as the unified (“Q+K”)

approach, EMMA, compression of mixed linear model and P3D. For example,:

A. Linkage disequilibrium (D’, R* and P value) were calculated by TASSEL'.

B.  Association analyses were performed with the mixed linear model approach’ implemented by
TASSEL'.

C. GWAS was performed with the compressed mixed linear model approach®’ carried by
TASSEL' which also implemented the EMMA?® and P3D* algorithms to reduce computing time.
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INDEX

2D Plot, 34 LD Plot, 35

Analysis Mode, 25 Linkage Disequilibrium, 26
Annotated alignment, 14 menus, 38

BLOBs, 12 Mixed Linear Model, 30

Chart, 36 MLM, 51

Cladogram, 27 Numerical data, 14

Collapse Non Major Alleles, 19 Open source code, 8

compressed MLM, 31 P3D, 31

Compression, 31 Panels, 8

compression level, 31 PCA, 21

Data Mode, 10 Plink, 12

data tree, 38 Population parameters previously determined, 31
Diversity, 25 Principal component analysis, 21
EM algorithm, 30 Principal Component Analysis, 42
EMMA, 30 REML, 30

expectation and maximization algorithm, 30 Restricted Maximum Likelihood, 30
File Menu, 38 Result Mode, 33

Flapjack, 13 Sites, 16

GDPC, 10, 54 SNP Extract, 27

General Linear Model, 28 Specified number of rows, columns, and labels. See Kinship
Genome-Wide Association Study, 53 Square Numerical Matrix, 15
Genotype Numericalization, 18 Stand-alone, 8

GLM, 47 Synonymize Taxa Names, 21
Hapmap, 12 Table, 33

Henderson. See MLM Taxa, 17

Heritability, 30 Traits, 17

Impute Phenotype, 20 Transform, 18

Impute SNPs, 18 Tree Plot, 33

Intersection Join, 24 Union Join, 23

Join, 23 Web start, 7

Kinship, 15, 28, 30, 46
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